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Welcome! 

 

Thank you for choosing Gradience™ Records to track your company's employee information. Our 
software application includes many features based on the suggestions of our customers, and we 
certainly welcome any further comments or suggested improvements you may have.  
  
When combined with other Gradience software such as Gradience Attendance and Gradience 
TimeClock, this powerful tool helps you keep critical employee information without entering data 
twice.  
  
Software Features:  

• Open-ended licensing – Unlike many human resource software applications designed for 
large companies, Gradience Attendance does not require annual licensing. However, we 
do encourage you to purchase upgrades so that you have the latest enhancements and 
newest features to make your job easier.  

• Easy, standalone PC installation – We designed Gradience to be simple to install and get 
running, even for a large client-server system.  

• Password security – Anyone who uses the program must have a login ID and password, 
and you can set different access levels for each user. Additionally, users can encrypt 
sensitive database data such as Social Security numbers. This feature provides peace of 
mind in the event a database or server hard drive containing employee information is lost 
or stolen.  

• Data import – If you already have information from a spreadsheet or other program, you 
can save time setting up Gradience Attendance by importing it.  

• Reminders – Set pop-up reminders for important dates, such as employee anniversaries, 
birthdays and reviews.  

• Reports – You can choose from 18 standard reports and change options to get the 
information you need. Export information to other file formats such as Excel or text, too, as 
well as build your own reports with the powerful Custom Reports module included.  

• Automatic backup – Gradience Attendance can make sure you have a backup of your 
important employee information each time you close the program. With the included DB 
Monitor and DB Maintenance utilities, you can also schedule server backups and perform 
routine database maintenance.  

• Unlimited employees – This application lets you manage attendance records and time-off 
for unlimited employees.  

• Automatic Updates – Automatic Updates help you keep your applications current via the 
Internet. This setting can be manually turned on or off in case automatic updates are not 
desired. 



Gradience Records — New Features:  

• AutoUpdate** – With the AutoUpdate feature you can set the application for automatic 
updates or manually check for updates at any time.  

• Expanded Performance, Accidents, Warnings and Separations Features – These 
areas now allow you to document more thoroughly than ever with additional information 
fields.  

• Add file attachments to notes/comments – Store all documentation in one place! Attach 
Word, Excel, PDF and image files to any notes or comments field. For instance, you can 
attach a Gradience Forms™ FMLA Request Form to the comments field of the Benefit 
Detail screen for that employee. There’s also a full text editor available now.  

• Quick print reports – In each program feature, you’ll find a print icon that lets you quickly 
create related reports. Combined with the new, faster Employee Select Column, this 
makes printing reports a breeze.  

• Familiar interface design – No need to re-learn how to use Gradience. For customers 
using Gradience Records in concert with Gradience Attendance or TimeClock, a single 
login/password will grant access to all three programs. 

**Note: Updates versus Upgrades — Updates (also called minor updates) are new releases 
where the first version number has not changed. For example, if you purchase a Gradience 
product with version 10.x.x., you can update to any other version 10.x.x free of charge. Upgrades 
(also called major upgrades) are indicated by a change in the first version number. For example, 
when Gradience improves to the next higher first version number (from 10.x.x to 11.x.x), this is 
called a major upgrade. Major upgrades usually have a significant amount of new features and 
software improvements which warrant an additional charge. Upgrades require an upgrade fee. 
When Gradience performs an AutoUpdate, the fixes applied are minor updates, and are available 
free of charge. Contact Gradience sales for more information on how to purchase major 
upgrades.  



Unlocking the Demo       

You can unlock your demo copy after a new installation, or after you already have installed the 
program.   
  

New Installation 
  

You can unlock your installation immediately, or run any Gradience application in Demo mode. 
Here’s how: 

• During the installation of any Gradience application, you will be prompted to enter your 
license key in the Product Key window. 

• Enter the key in the Key field, or click Next to continue installing the application to run 
Gradience in Demo mode. 

• After running the applications in Demo mode, you will be reminded periodically of the 
Demo trial period remaining and have the option to purchase Gradience Attendance, 
Records or TimeClock. 

Previous Installation   

If you already have installed the demo of Records, you can unlock it in one of two ways: 

1. Open Gradience Records and click Enter Product Code to enter the product key. 
2. When the Enter Product Key window opens, enter your product key. It is not case-

sensitive. 
3. Click OK. A pop-up will indicate whether the key is valid or not. 

or 

1. Open Gradience Records and click Continue in Demo Mode, enter the login and 
password. 

2. From within the program, click Help. On the drop-down menu, click Alter Current Product 
License. 

3. When the pop-up window opens, click on Edit Key. 
4. When the Enter Product Key window opens, enter your product key. It is not case-

sensitive. 
5. Click OK. A pop-up will indicate whether the key is valid or not. 

Note: There is a different product key for each Gradience product. 
  



System Requirements  

 

• Windows XP Professional (SP2), Windows 2000 Professional, Windows 2003 Server or 
Windows Vista 

• Pentium IV or Higher Processor 

• 512 MB available RAM (Random Access Memory) 

• 60 MB available hard disk space CD-ROM drive 

• SVGA monitor with 1024 x 768, High Color or higher 

•  Windows-compatible, graphics-quality printer 



Network Requirements       

• Windows-based Server or PC –  The included database is not compatible with a non-
Windows-based operating system, such as Novell. However, you may run the database on 
a Windows-based server or PC connected to a non-Windows based network.  

• A static (persistent) IP address so the database will always be connected to the client 
application. 

• Proper user license – The database will only allow the purchased number of users to be 
connected at any one time to the database. Wide-Area Networks (WAN) require an 
Enterprise license. The Product Key is affixed to the inside cover of the QuickStart Guide. 

• CD-ROM drive or access to our software download area on www.gradiencesupport.com.  

Citrix and Terminal Services: 
 

   

Although some of our customers have reported running the Gradience with Citrix we have not 
tested our software in such an environment. Also, the Gradience technical assistance is only for 
the applications themselves and not for troubleshooting network issues. We therefore cannot 
offer help with installation on your Citrix network. We also cannot guarantee that standard 
approaches to issue resolution offered by our Technical Support team will work in this 
environment.  
  

You may use the link below to access a PDF that may help.  
  

Citrix support 
  

Below is the only information that we can offer regarding Terminal Services.  
  

Standard Client/Server install on a Terminal Server  
Install the gradience product on the Terminal Services Server using the Add/Remove programs in 
the Control Panel.  
  
 On the Server where gradience is installed, go to Start, Run and enter: hrware.ini. This will 
bring up Notepad with the following info:  
[HRWARE]  

Server=Localhost  

Path=C:\Program Files\GNeil Software\Data\HRWare.gdb  

  

Change the Server information from:  
SERVER=LOCALHOST to SERVER=127.0.0.1. 

Even though Localhost is the same as the IP Address of 127.0.0.1, we have found that in many 
cases you will need to enter the IP Address instead of the name.  
  

We also found that the User would need to be logged on to the Terminal Service with 
Administrative rights. Without administrative rights, our database engine (Firebird 1.5) will not 
function, and the user will not be able to access the database file.  
  
This suggests that an Admin user has privileges to system files/DLL’s that a standard user would 
not. 
  

We welcome your sharing with us any insights that you gain from deploying our software on Citrix  



License Options        

Gradience products have similar licensing schemes. The options currently available are:  

• Professional  – Up to five users can run the program at the same time when connected to 
a single, common database. 

• Enterprise – Site License – Any number of users can run the program at the same time 
when connected to a single, common database from a single site (location).  

• Wide-Area Network (WAN) – licenses for multiple locations are also available. Please call 
for more information. 

   



Installing from the CD Menu        

To begin installing Gradience, follow these steps: 
1. Close ALL running programs.  
2. Insert the Gradience CD-ROM into the appropriate drive of your computer.  
3. The menu will appear. Select which product you want to install. (If the installation menu 

does not appear, click Start, Run. The Run dialog will appear. In the dialog box, type 
D:\setup.exe where D: is the letter of your CD-ROM drive. Click OK or press Enter. ) 

4. Once the installation procedure begins, follow the on-screen instructions to install the 
software. See Setup Types below for more information. It is recommended that you 
accept the default setting for each step of the install process. If you are installing the 
software in a network environment (Client-Server Installation), you should consult your 
network administrator before installation. You must have proper network rights in Windows 
2000 and XP to install Gradience software. 

5. When installation is complete, the Gradience program group will be added to your Start 
menu, and a Gradience TimeClock icon will be on your desktop. 

   



Setup Types       

• STANDALONE: Use this option if you are installing to a standalone computer. This will 
install the application files and database files to your local drive.  

• SERVER: This is the first of two steps in the Client-Server Installation, either for true client-
server configurations or a peer-to-peer network that may be using a workstation PC for the 
database. Choose this option to install the database and application files on the Server 
and before installing the Client application to PC workstations. 

• CLIENT: This is the second step in the Client-Server installation. This will install the 
application files and ask for the Server Name and Database Path. 

   

After clicking on a Setup Type, you will have the following options: 

• EXPRESS: We recommended that you select this option if you are installing or upgrading 
Gradience for the first time. This will take you through the installation process with 
minimum user intervention.  

• CUSTOM: This option is for Advanced Users who have specific installation needs, such as 
installing just the Time Station program on a client.  



Installing Gradience Records 

This section explains how to install Gradience Records to a Network or Standalone computer, 
and answers frequently asked questions about installing.  
   

Gradience Records can be installed on a single standalone workstation or a network for database 
sharing among several users, depending on your needs.  
   

Regardless of which license you purchased, you may install the database to a network folder for 
the purpose of backup. Please consult your network administrator before installing to a network 
folder.  
   



Network Installation – (Client-Server)       

Installing a Client-Server setup is a two-step process. You will need to install to the Server first 
and then to the Workstation(s).  
   

To install to a network requires these items: 

• Windows-Based Server PC – The included database is not compatible with a non-
Windows-based operating system, such as Novell. However, you may run the database on 
a Windows-based server or PC connected to a non-Windows-based network.  

• A static (persistent) IP address so the database will always be connected to the client 
application. 

• Proper user license – The database will allow only the purchased number of users to be 
connected at any one time to the database. Wide-Area Networks (WAN) require an 
Enterprise license. The Product Key is affixed to the inside cover of the CD sleeve. 

• CD-ROM drive or access to our software product download area on 
www.gradiencesupport.com. 

   
NOTE: Gradience cannot provide technical assistance with setting up or maintaining your 
computer network. Please consult your computer manufacturer or network administrator before 
contacting Gradience Tech Support. 
   



Installing Gradience 

1. You may install from a CD or from a download. 

• From a CD:  
Insert the gradience CD, select Install gradience software and double-click on the program 
to be installed.  

• From a Download: 
After following the instructions on downloading Gradience to your desktop, double-click on 
the file to install.  
 
Note: To download, go to www.gradiencesupport.com, click on Download latest 
versions. Select the program that you need, click Download and then click Save. When 
the Save as window opens, put Desktop in the Save in field and then, click Save. 

2. You may install as a Server, a Client or a Stand Alone. 

• Server Installation: 
If installing several gradience programs on your network, only one program needs to be 
installed at the server.  
 
When prompted for the type of installation select Sever. When prompted for Custom or 
Express we recommend Express. If you select Custom you will be given the chance to 
“deselect” certain components. We recommend that you leave all components checked. 
The next prompt will allow you indicate where you want the database to reside. Please 
indicate a folder on physical drive rather than on the drive directly. An example of a custom 
path would be… 
 
j:\gradience\hrware.gdb  
 
Continue to follow the prompts. You will see a screen that shows where the database is 
located. Jot this location down or print this screen as prompted. You will use it at the client 
to verify that it is “pointed” properly to the database.  

• Client Installation: 
DO NOT map a drive from the client to the server. Our software uses TCP/IP to connect to 
the database via port 3050. Also DO NOT use UNC (\\) in either the name of the server or 
the path to the database.  
 
When prompted for the type of installation select Client. When prompted for Custom or 
Express we recommend Express. This workstation will look across the network and “self-
point” to the data up on the server. A prompt will indicate where this client is “pointed”. 
The client MUST be pointed to the exact drive letter on the server where the database is 
located, not a mapped drive. Be sure that the path to the database does NOT have double 
back-slashes (UNC) in the path.  

• Stand Alone Installation: 
When prompted for the type of installation select Stand Alone. When prompted for 
Custom or Express we recommend Express. If you select Custom you will be given the 
chance to “deselect” certain components. We recommend that you leave all components 
checked. The next prompt will allow you indicate where you want the database to reside. 
The database must reside on a physical drive and in a folder on that drive rather than on 
the drive directly. An example of a custom path would be…  
 
j:\gradience\hrware.gdb  



Possible Launch Error:  
 If after installation, you attempt to open gradience software from a remote location you may 
encounter an error message. Some remote-access software cannot resolve Localhost or the 
“name” of the server that can be found in the hrware.ini file of the server, client or stand alone 
workstation respectively. 

Resolution: 

1. 1. Remote to the desktop of the PC where you are attempting to open the program. 
(Server, Client or Stand Alone PC)  

2. 2. Click on Start > Run and enter hrware.ini into the field and click OK.  
3. 3. Second line from the top, change the “Server Name” or “Localhost” to the IP Address of 

the computer where the database is located.  
4. 4. Save and close the NotePad. Re-launch the program. If this fails, “physically” go to that 

computer to launch it.  
 
 

  IMPORTANT NOTE FOR VERSION 6 AND EARLIER USERS 

Gradience does not share the same database with Version 6 or earlier. You will need the 
Gradience Version of each program to share the database among the three separate programs. 
For this reason, you also should upgrade each program to the Gradience Version at the same 
time as ; otherwise, you may create multiple non-synchronized databases. 



Quick Note About Peer-to-Peer Installations       

A peer-to-peer connection allows you to share information between two computers without the 
need of a formal client-server connection. The peer-to-peer connection must be in place 
before following these instructions. See your Network Administrator for more details on setting 
up such a connection.  
   

On the host computer (the one on which you wish the database to reside), follow the instructions 
for a Server installation. Write down the Server Name and Database Path when prompted.   

Note: The Server installation will install both the software application and database files to the 
host computer. Then install the application as a Client on the other computer that will be sharing 
the information, entering the Server Name and Database Path when prompted. 

   



Upgrading from Optima or MyBiz to Gradience 

Version 7 and early editions of Version 8 utilized InterBase 6 open edition as a database engine. 
Nearly all PCs now come with hyper threading as a standard feature. Because of this, we no 
longer employ InterBase 6 because it doesn't work well in a multi-processor or a hyper-threaded 
environment. 
  

We now use Firebird 1.5 as our database engine. It works with multi-processor environments and 
we know of no issues with any brand of hyper threading available. When upgrading to Gradience, 
Firebird will NOT automatically replace InterBase. You will have to uninstall InterBase first as well 
as deleting the gds32.dll file. Then, install Gradience so that Firebird will install as your database 
engine. 
  

If you're upgrading from Optima or MyBiz to Gradience follow these steps: 
1. Back up your current data first. 
2. From your Control Panel click Add/Remove Programs. Look for InterBase 6 and uninstall 

it if you are not using it for another application. If you do not have InterBase 6, you may 
already have Firebird. If so, disregard Steps 3 and 4 below. 

3. After uninstalling InterBase 6 close out of Add/Remove Programs and return to the 
desktop. 

4. Do a search of your C: drive for gds32.dll. If you have this file, delete it. 
5. Now install Gradience. No data needs to be imported. Gradience will read the database 

you already have and upgrade it to a Gradience database. 
  
Note: DO NOT continue to use Optima or MyBiz. These programs will still be able to access the 
data. Using the older version to access the Gradience database may result in a loss of data. 
   

Updating from versions older than Version 6 

  
IMPORTANT! If you have been using Version 6 or below of Attendance Controller first make sure 
that your Benefit Labels are as follows: 
Vacation 

Sick 

Personal 

  

If your Benefit Labels are different, the database will not convert properly for Gradience to read it. 
  

The database in Version 6 and below is dramatically different from what has been used since 
Version 7. If you're upgrading from a version below 6, you will need to upgrade to Version 6 first 
and then to Gradience 2007 (Version 9). Version 6 is on the Gradience CD under the 
BIN/Legacy folder. For assistance, please contact Tech Support at 888-925-7740 or go to 
www.gradiencesupport.com and click on Ask a Question. 
  

Updating from Version 6 

  
IMPORTANT! If you have been using Version 6 or below of Attendance Controller first make sure 
that your Benefit Labels are as follows: 
Vacation 

Sick 

Personal 

  

If your Benefit Labels are different, that database will not convert properly for Gradience to read it. 



  

To upgrade from Version 6, follow these steps: 
1. Install Gradience 2007 (Version 9). For assistance, call Tech Support at 888-925-7740 or 

go to www.gradiencesupport.com and click Ask a Question. 
2. From the desktop click on Programs (or All Programs) > Gradience > Maintenance 

> DB Monitor. 
3. Login with ADMIN, ADMIN 
4. After the DB Monitor opens, click File and Exit and then, click Yes to shut it down. 
5. Now, install Gradience 2008 (Version 10). 



Auto Update Notification for Gradience Records  
(Pro/Enterprise) 

Periodically, FREE updates may become available for this version of Gradience Records.  
 

 

 When opening the program; if an update is available, the pop-up shown above will appear.  

Accepting the update: 

1. Click See what’s new to be directed to the Web page that contains the download link for 
the program that you need to update.  

2. When the pop up window opens; click Save. If you click Run the software will not install.  
3. A Save as window will open. In the Save in field enter Desktop and click Save to 

download the update.  
 

 



 
 

4. Once the download is complete; an installation icon like the one shown here will appear on 
your desktop.  

 
records.exe 

Installing the update:  

1. Double click the installation icon to begin installing the update. You may also refer to the 
section on installation in the Help file within your program for more details.  
 
• Server Installation: 
Install the update on the server or on a workstation that is “behaving” as a server for our 
program first before installing the update on individual “client” workstations. Ensure that 
your current version is not open. Double-click on the downloaded installation icon. When a 
prompt gives a choice between Server, Client and Standalone, select Server. When a 
prompt gives a choice between Custom and Express, select Express. This is true even is 
you had done a Custom installation originally. This is because you already have an 
established ini file [hrware.ini] that will properly direct the program to the data.  
 
• Client Installation: 
Now move the installation icon to the desktop of a client. When a prompt gives a choice 
between Server, Client and Standalone, select Client. When a prompt gives a choice 
between Custom and Express, select Express. Repeat at any additional client 
workstations running this software.  
 
• Stand Alone Installation: 
If you only have the program on one computer and the data is also on that same computer, 
double-click on the downloaded installation icon. When a prompt gives a choice between 
Server, Client and Standalone, select Standalone. When a prompt gives a choice 
between Custom and Express, select Express.  
 

2. When the installation is complete, click the original program icon to open the program.  
3. From within the program, click Help > About to view the updated, multi digit version 

number.  
4. Make a record of this full, multi digit version number. When contacting Tech Support, 

indicate this number.  

Choosing not to update at this time:  

1. Click Remind me later.  

Note: At any time while using the software, you may click on Help at the top. From the drop-down 
menu click Check for Updates. If one is available you will see the pop-up shown here.  
 



 
 

 If no update is available, the pop-up shown below will appear.  
 

 



Before You Begin 

Before you begin using Gradience Records, follow this checklist to get started quickly. 

 PLEASE HAVE READ AND FOLLOWED THE PRECEDING CHAPTER ON INSTALLATION 
BEFORE INSTALLING ANY Gradience program.  

Also, have available:  

• Location and Department names  
• User Information (Managers and other users that will have access to the data)  
• Employee Data  
• Employee Name,  
• Hire Date,  
• Work Status (full or part time),  
• Active Status (Active, Inactive, or Terminated),  
• Location and Department,  
• Work Hours  
• Week Hours 

  

  

  

  

  

 

  

  

 

 

 

 

 

 

 
   



Auto Update 

Single PC without IT support  

•••• PC needs Internet and FTP access 

•••• User must have PC and Network Administration privileges to complete these tasks. 

Turn on Auto-Update (Client PC)  

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings – Select “Enable Auto 

Update”  
3. From Help Menu – Select “Check for Updates”  

Multiple PCs without IT support  

• User must have PC and Network Administration privileges to complete these tasks.  

Option A 

1. Follow the same steps as used for a single PC environment. 

Option B 

• Gradience Version 10.0.712.13 or higher  
• One of the PCs must have Internet and FTP access  
• Must set up Network Shared Folder for GNSiteMirror application to write to it and for 

other PCs to read from it. The GNSiteMirror application replicates the FTP Update site to a 
local PC or Server.  

 Install GNSiteMirror application   

• See below. 

PC with IT support  

• An IT Administrator must perform these tasks 

Option A   

1. Follow the same steps as used for a single PC environment. 

Option B 

• Gradience Version 10.0.712.13 or higher  
• One of the PCs must have Internet and FTP access  
• Must set up Network Shared Folder for GNSiteMirror application to write to it and for 

other PCs to read from it. The GNSiteMirror application replicates the FTP Update site to a 
local PC or Server.  



Install GNSiteMirror application  

• See below. 

Turn on Auto-Update (Client PC)   

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings “Enable Auto Update”  
3. From Help Menu – Select “Check for Updates”  

Turn Off Auto-Update (Client PC)  

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings – Deselect “Enable Auto 

Update”  
3. Use the management tool of your preference to perform the software installation.  

GNSiteMirror Installation: 

1. Installing the gnsitemirror.msi download application 
- Installing from Gradience CD:  
Navigate to the Gradience CD > BIN > Gradience > Site Mirror folder and double click on the 
Gradience Site Mirror.msi file.  
- If you don’t have a Gradience CD, you can download the file from our Website at: 
http://downloads.gneiltechsupport.com/downloads/Gradience Site Mirror.msi  
After downloading, double-click on the file to start the installation process.  

2. Point the gnsitemirror application to a shared folder 

a. Start the gnsitemirror application. You can find the shortcut at Start > Programs > 
Gradience > Gradience Site Mirror. This will place an icon in the System Tray (near the 
clock in the bottom right).  

b. Right-click on Gradience Site Mirror select Settings.  
c. In the Select Download Folder box, enter the shared path down to the folder where you 

want the clients to pull the updates from. The path will be created if it doesn’t already exist. 
This folder will need to be shared so others can map to it.  

d. Select the options:  
Days between updates (minimum of 7 days) – this is how often this computer will check 
for updates from the FTP site.  
Update Time (computer must be turned on to check updates) – this is when you want this 
computer to check for updates.  
Start Gradience Site Mirror each time Windows starts – (Recommended) – allows the 
program to start automatically each time the computer is restarted.  

e. Click OK.  
f. Right-click on the icon in the System Tray and select Update Now. This will download any 

available updates for the current version.  

3. Set the Auto Update Settings for each Client Computer 

a. From each client computer, open the Gradience program.  
b. Go to Settings > Global Preferences > General Settings Tab and enable the option for 

Automatic Updates. Close out of the Global Preferences.  
c. Go to Help > Auto Updater Settings and set the path to the shared folder.  



Checklist for Setting Up 

Gradience Records first needs to collect some information in order to correctly track your 
employee absences. To get started, please follow the checklist below:  

• Change Administrator Password 
• Set Up Locations and Departments 
• Set Up Global Preferences 
• General Codes 
• Enter Employee Data 
• Add additional users  



Changing the Admin Password       

Option One: Setup rights from scratch.  

Option Two: Duplicate the rights of another user.  

  

See Note at the bottom of these instructions.  
  

Option One: Setup rights from scratch. 
1. From any screen, click Settings > User Security.  
2. Click the New and enter new log-in and Full Name.  
3. Enter new Password and enter password again in the Verify Password field.  

 
Feature Access- By default, the Detail button (not Employee Detail) will be depressed. A 
feature list associated with the Detail button will appear at the lower right,  

1. Click on each item in the Access Rights column one at a time. When you do, the item will 
highlight and a down arrow will appear. Click on the down arrow and a drop-down menu 
will appear.  

2. Click on the selection that provides the appropriate level of access. Repeat this for each 
item on the list of features. You will have an additional button on your screen for each 
Gradience program installed:  

•••• Gradience Attendance  

•••• Gradience Records  

•••• Gradience TimeClock  

•••• Gradience COBRA  
Click each of these buttons respectively and repeat steps 1, 2 & 3 directly above. This will inform 
the database as to the level of access this person will have for each program loaded. Do this only 
once.  
  
Now click the Location/Department button and ensure that the appropriate Locations and 
Departments are checked. If you wish to have access to selected features for all locations and 
departments, you will need to check them all.  
  

Option Two: Duplicate the rights of another user.  
1. Click Settings > User Security and highlight the user who’s rights are to be duplicated. 

To have your “new” administrative password “automatically” have the same, full rights as 
the default administrator login; highlight ADMIN on the list on the left. See first “Note” at 
the bottom of these instructions.  

2. Click the double-green checkmarks (Save as) button at the top. A pop-up window will 
open.  

3. Enter the new login, enter the name of the new user, enter the new password and enter 
the password again.  

4. Click Save.  
  

Notes:  
1. To deactivate ADMIN, Click on ADMIN on the list on the left and then, under Is User 

Active, click No.  
2. To “nearly” duplicate another user’s rights, follow the steps in Option Two but before 

saving, “change” the access rights to those features that need to be restricted or 
enhanced. Then, click Save.  

   

   



Creating Locations and Departments       

Locations and Departments are required and must be assigned to each of your Employees (See 
Adding New Employees to assign Location/Department to employees). 
   
Note: When setting up Locations and Departments for the first time, a Location must be set up 
first, and then you may assign a Department to that Location.   



Setting up Locations and Departments 

Setting up Locations and Departments is a critical task and must be performed before you can proceed with 

other data entry steps. During the process, you will create Locations first, and then Departments afterward. 

Departments then can be assigned to Locations. Follow these steps: 

1. Click on Settings > Locations/Departments.  
2. With Locations already selected, click New, enter the name of the new location and click 

Save. All of the departments that have been created thus far will be made available to the 
new location. Simply check those departments that are appropriate to the new location and 
leave unchecked any departments that do not apply to the new location.  

3. To create a new department, click Departments and then click New.  
4. Enter the name of the new department and click Save. It will be available to all locations. 

Assign as needed by checking the new department for each location for which it is valid. 
Leave it unchecked for those locations for which it is not valid.  
 
Note: After creating new Locations or Departments, you need to refresh the Employee 
Detain screen for them to be available. To do so, look to the upper right. Just under the 
Gradience logo click the black X in the white box.  

NOTE: As you add more locations and departments, you will see that each location has ALL of 
the departments you have created. However, only those departments you assign to a location will 
show up when assigning them on other screens. You may not remove a Department from a 
Location if an Employee is still assigned to that Location/Department combination. After adding 
and editing locations and departments, they may not immediately be available on the drop-down 
menu on the Employee Detail Screen. While on the Employee Detail Screen, click the "X" below 
the Gradience logo in the upper-right corner. Then, return to the Employee Detail Screen and the 
new location/department should be available.   



Setting up Global Preferences        

Global Preferences allow you to control your default program settings, such as Company Info, 
Report Options and specific program options.  
  

See below for detailed information on each tab. 



Company Info Tab  

The Company Information screen allows you to enter your company name, address and logo. We 
recommend entering the company name and logo because these will print out on Reports.  
Feature Description 
Company 
Name 

(Recommended) This will display on the report heading.  

Address, 
City, 
State, ZIP 
and 
County 

(Optional)  

Remove 
Current 
Logo 

This allows you to unselect the current logo. 

Assign 
New Logo 

This allows you to select a new logo. This logo will display on the top left of reports. 

Save 
Logo to 
disk 

This allows you to save the current logo to disk or to your hard drive.  

   



Editing Company Info 

Follow these instructions to edit the company info: 
1. Click Settings, Global Preferences. Enter information as needed. 
2. Click Save.  

   



Adding a Company Logo 

If you have your company logo available in a bitmap (. bmp) or jpeg (.jpg) file format, you can 
have this logo appear on reports. Gradience supports .bmp and .jpg file formats not to exceed 
200 x 200 pixels in size. The logo will appear in the top left when you print a report. 
   

To add a company logo, follow these steps: 
1. Click Assign New Logo.  
2. Navigate to the directory where the company logo is stored. It can be in a .bmp or .jpg 

format no bigger than 200 x 200 pixels in size.  
3. Click on the logo and then click on Open to select it.  
4. Click the Save button.  

   



Saving Logo to Disk 

You may save the logo to a directory on a disk or hard drive. When you add a logo within 
Gradience, the logo is actually saved within the database file.  
   



General Settings Tab 

The General Settings screen allows you to enter the default hours in a day that employees will be 
assigned, and allows use of the Forgotten Password Utility. This screen also allows settings for 
Forced Writes to Firebird and prompting to backup on exit.  
   

Feature  Description 
Epoch 
Setting 

We strongly recommend keeping the default settings. This setting will allow the Gradience program 
to appropriately interpret any two-digit year entered that is between 1920 and 2019. For example, 
with the default Epoch setting of 1920: 

• If you enter a date (such as in the Hire Date field) of 03/05/01, the program will interpret this as 
03/05/2001. 

Note: If you need to enter a year before 1920 or after 2019 in a date field within the program, you 
may enter the year as a four-digit number.  

Default 
Hours in 
a Day 

These are the default hours that will be assigned when creating a new employee. The Day Hours on 
the Employee Detail screen will be filled in automatically with these default hours when a new 
employee is created.  

National 
ID 
Number 
Format 
/Label 

Selecting one of these options will allow you to set the mask for the National ID Number Format. The 
default mask is set to the USA SSN format. With this selected, whenever you enter a new employee, 
the dashes automatically will come up in the xxx-xx-xxxx format. The label is the title that will appear 
on the Employee Detail screen. 

   

Feature Description 
Allow use 
of 
Forgotten 
Password 
Utility 

This option allows access to a utility that can be used, only with assistance from Tech Support, to 
gain access into the Gradience program. Call Tech Support if you have forgotten or lost your 
Gradience password. 

   
Forced 
Writes for 
Interbase 

•  If running the Gradience database on a Standalone computer, this option will help to keep the 
database more stable. A Workstation is more prone to lock up or crash than a Server. If the 
Gradience database is installed on a Workstation and the program is open at the time the 
computer locks up or crashes, the database is prone to becoming corrupt and possibly 
irreparable. A computer lockup or crash can be attributed to several things, including having 
too many programs open at the same time than what your computer memory can handle.  

• If the database is installed on a Workstation or Standalone computer, we recommend keeping 
this option checked. The performance may lag a little, but unless you have more than 800 
employees, you may not even notice it. We also recommend having a current backup, created 
within Gradience or DB Monitor, available. If the database is installed on a Server, normally a 
backup of the whole Server is created on a daily or regular basis. We still recommend setting 
up Scheduled backups within DB Monitor, but having this option checked is not as important 
on a Server. 

  

Prompt 
for 
backup on 
Exit  

This option allows you to turn on or off the message prompting for backup when you close out of the 
program. Backups are very important. We recommend that you turn this feature off only if you have 
scheduled backups within the DB Monitor.  



Report Options Tab 

The Report Options settings affect how reports will appear by default.  
Feature Description 
Print 
Preview  

Toggles (turns on and off) showing preview first before printing 

Header 
Bold  

Toggles bolding for Header Title 

Header 
Line  

Toggles putting a line under the Header Title 

Header 
Shade  

Toggles shading for Location or Department title row 

Data 
Line 

Toggles lines to separate data information 

Print 
SSN 

Toggles ability to show Social Security Numbers  

Print 
Picture  

Toggles ability to print Picture on printout 

Print 
Totals  

Toggles whether Totals show up on reports 

   



Editing Report Options 

To Edit Report Options, follow these steps: 
1. Choose an option by clicking in the box.  
2. ClickSave.  

   



Attendance Tab 

The Attendance Tab will show only if Attendance is installed. 
   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



Adding Employees       

You may get to the Employee Detail Feature by selecting Employee Detail under the Feature 
Column. 
   

All employees are entered through the Employee Detail screen. From here, you can enter their 
names, Social Security Numbers (optional), Hire Dates, Job Titles, and other pertinent 
information. This information is shared among Gradience Attendance, Records and TimeClock. 
This means that when you enter this information in one program, you’ll be able to see it in the 
other Gradience programs. 
   



Required Fields 

The following fields are required: First Name, Last Name, Hire Date, Work Status, 
Employment Status, Location, Department and Day Hours. SSN is not required in Gradience, 
but may be required when exporting Timecard Runs for certain payroll programs. 
   

To add a new employee, click New. (See Required Fields.) Click Save after entering employee 
information.  
  

Note: Locations and departments must be set up before entering new employees. (See 
Locations/Departments to set these up.) 
   



Setting Up General Codes 

To access General Codes, go to Settings, General Codes.  

1. General Codes allow you to set up codes in addition to the ones already included in the 
program. For example, if you have Performance Rating selected from the Select Code 
column, you may add Fair if you so choose.  

2. To add a new code, select the appropriate category from the Select Code column and click 
New.  

3. Click in the blank Code Value block and enter the new code (For Example, Life Insurance - 
Self).  

4. Double-click the Enabled block (adds a checkmark) and click Save. This will allow all 
codes selected to be viewed on the specific screen. For Example, if you click on the 
Benefits tab on the main menu, and click Benefits List, you will see the code Life 
Insurance-Self.  

5. Click Save.  

Follow the above steps to add new codes to any of the category listings.  

A code cannot be deleted if it is in use. To delete a code, click on the appropriate code and click 
the Delete key. A message will pop up to confirm deletion and let you know if the code is in use.  

Using the Enabled feature:  

If you deselect a code by unchecking the Enabled block next to a Code, it will not show up as a 
selection in the drop-down box for the appropriate feature.  

Select Code Definitions: 

• Addresses Type – This allows you to set codes for the list that will appear under Personal 
Contacts , Address, Address Type.  

• Benefits – This allows you to set codes for the list that will appear under Benefits, Benefits 
List.  

• Education Degree – This allows you to set codes for the list that will appear under 
Education, Degrees.  

• Education School – This allows you to set codes for the list that will appear under 
Education, School.  

• Employee Relations – This allows you to set codes for the list that will appear under 
Personal Contacts, Detail, Relations.  

• Performance Rating - This allows you to set codes for the list that will appear under 
Performance, Ratings.  

• Performance Reasons - This allows you to set codes for the list that will appear under 
Performance, Reason.  

• Salutation– This allows you to set codes for the list that will appear under Personal 
Contacts , Detail, Salutation.  

• Separation Reasons – This allows you to set codes for the list that will appear under 
Separations, Reason for Separation.  

• Separation Type – This allows you to set codes for the list that will appear under 
Separations, Separation Type.  

• Training Certificate Names – This allows you to set codes for the list that will appear 
under Training, Certification.  

• Training School – This allows you to set codes for the list that will appear under Training, 
School.  



• Training Seminar – This allows you to set codes for the list that will appear under 
Training, Seminar.  

• Wages Reasons – This allows you to set codes for the list that will appear under Wages, 
Reason For Change.  

• Warnings – This allows you to set codes for the list that will appear under Warnings, 
Warning Type. 



Security Options 

Due to the confidential nature of information stored in Records, security is always turned on. This 
will help prevent unauthorized persons from accessing critical employee data. The use of security 
is required, and setting up access to Records and any other Gradience programs you have, 
should be the second thing you do. The first thing you should do (after changing the Administrator 
password) is set up Locations and Departments.To view the setup tasks you should perform, and 
the order in which they should be performed, click Help > Checklist from the main menu.  

You may set up access for managers to view only their departments and/or view specific 
employees from other departments. You may also set up employees to have read-only access to 
their records.  

Encrypt Data feature 

Gradience Attendance contains a Global Preference > General Settings button called Encrypt 

Data. By clicking Encrypt Data and entering the secret key of your choice, sensitive information 
such as Social Security Numbers can be encrypted in the HRWARE database. This feature can 
help prevent the casual viewing of Social Security numbers by unauthorized persons.  

To decrypt your data, simply navigate back to the General Settings and click Decrypt Data. Your 
data will no longer be encrypted.  



User Security - Detail Tab 

Features common to Gradience Records, Attendance, TimeClock and COBRA 

• Search For – This allows you to search by User Name.  
• Save As – This allows you to create additional users based on the access rights of another 

user.  
• Employee Record Access – This allows access to view, add or delete employee records.  
• Employee Detail – This grants access to the Employee Detail screen.  
• View SSN – This allows access to view Social Security Numbers.  
• Run Reports – This allows access to run reports.  
• Reminders – This allows access to add and delete reminders.  
• Reminders, Assign Global – This allows access to assign reminders as Global.  
• Reminders, Assign Users – This allows access to assign reminders to other users.  
• User Security – This allows access to add, edit, and delete users and user access.  
• Location/Department Maint – This allows access to assign location /department access 

for users.  
• Global Preferences – This allows access to edit global preferences.  
• Database Monitor – This allows access to the DB Monitor.  
• Database Backup – This allows access to Backup from the DB Monitor only.  
• Database Restore – This allows access to Restore from the DB Monitor. 
• Alter Product License – This allows access to enter a product key to change a license.   
• Product License. Conversion – This allows access to run the Conversion Utility.  
• Custom Reports – This allows access to create/modify Reports.  
• Import Data – This allows access to import employee data into the database.  
• Export Data – This allows access to export employee data.  
• Guest Users – This allows access to connect to the database via a third-party ODBC 

driver.  

Setting Access 

Setting up access to common features (Detail Tab).  

1. From the User Security screen, click Detail>New.  
2. Enter a Log In and Password (letters and numbers only) and the user’s Full Name.  
3. Select options for Displaying Reminder Alarms and Hints for this login.  
4. Select Yes to "Is User Active" to allow the user to begin logging in after giving access. 

Setting this option to No is a good security measure when users are out of the office for a 
number of days.  

5. Select what type of Feature Access users will have by clicking in the Access Rights field.  
6. Clicking on the arrow will allow you to select from the following:  

NO ACCESS – no access to selected feature  
READ ONLY – allows user to view only, cannot make any changes  
READ WRITE – allows user to view, add, and edit; no deleting allowed  
READ WRITE DELETE – allows user full editing rights to feature  
YES – allows access to feature  
NO – no access to feature  

7. Click Save.  

Program Specific Features: 

Records: 



•••• Show Records Tab – This allows access to the Records Tab. 

•••• Address – This allows access to the Address screen under the Personal Contacts 
screen.  

•••• Emergency – This allows access to Emergency screen.  

•••• Benefits – This allows access to the Benefits screen.  

•••• Benefit Plan Maintenance – This allows access to create, edit or delete Benefits. 

•••• COBRA – This allows access to the COBRA screen.  

•••• Personal Contacts – This provides access to the Personal Contacts screen that 
allows you to enter emergency and dependent information.  

•••• Taxes – This allows access to the Taxes screen.  

•••• Wages – This allows access to the Wages screen.  

•••• Performance – This allows access to the Performance screen.  

•••• Warnings – This allows access to the Warnings screen.  

•••• Education – This allows access to the Education screen.  

•••• Training – This allows access to the Training screen.  

•••• Accidents – This allows access to the Accidents screen.  

•••• Separations – This allows access to the Separations screen. 

•••• EEO/Other – This allows access to the EEO/Other tab.  

•••• General Codes – This allows access to the General Codes under Settings.  



User Security - Locations and Departments 

You should have already set up your Location and Department names (see Locations and 
Departments). Now you will want to set up users’ access to the Locations and Departments by 
following these steps:  

1. Click on Location/Department tab from Settings > User Security > Detail.  
2. Click on the “+” (plus sign) next to Locations/Departments and next to the location and 

department name to expand the list.  
3. Click in the check box next to the location and department name to select access to these 

areas or individual employees within these departments. This will put a checkmark in the 
box. Click in the box again to de-select (or clear) the item.  

4. If you have already entered your employees in the program and assigned location and 
departments to them, when you expand a department, you will see all the employees 
assigned to that location/department combination. You may then select access to 
individual employees at this point by clicking in the box next to the employee.  
 
Note: If you have not yet entered your employees (through the Employee Detail feature 
or Import Data under the File Menu) into the program, you will still be able to assign 
access to a location/department combination, just not down to the employee level. You 
may later assign access down to the employee level after you enter your employees and 
assign a location/department to them. 
 
 

5. Click Save.  



Managing Employee Records 

This chapter will help you become acquainted with the program layout and how to enter 
employee information. Throughout this chapter, there are examples of different program screens. 
You may wish to view the sample database to get a better picture of how employee records look 
once entered. 

Make sure you have gathered the following information for each employee before attempting to 
enter employee records: 

• Social Security Number 
• Name (First, Middle, Last)* 
• Employee Identification Number 
• Date of Hire* 
• Job Title 
• How many hours in a normal day the employee works* 
• Location* 
• Department* 
• Full or Part Time* 
• Active, Inactive or Terminated Status* 
• Time-Off Plan (Vacation, Sick, Personal, etc.)* 

 

* Required fields 



The Menu Bar 

  

File Menu 
• Maintenance->Backup Database – This lets you perform a database backup while running 

the program. 
• Import Data – Imports basic employee data into the Gradience database. 
• Export Data – Exports basic employee data from the Gradience database. 

(See Exporting) 
 

• Delete Employee – Deletes an employee from the Browse or Employee Detail screens. 
• Exit 
• MRU list – Allows you to quickly select an employee by clicking on his or her name. 

View Menu 

• Filter Page – Gives other options for sorting and filtering, such as hiding terminated or 
inactive employees. 

• Open Reminders – Brings up all open reminders (those not checked as resolved). 
• Open Reminders  – Allows access to all unresolved reminders. 

  

Settings Menu 
• User Security – Allows you to set user access to features, locations / departments and 

employees 
• Global Preferences – Allows you to set program preferences such as Company Info, 

Report Options and other program options 
• Guest Users – Allows you to set up user access for connection through an ODBC driver 
• General Codes – Allows you to add/edit fields for most drop-down fields 
• Locations/Departments – Allows you to add/edit locations and departments and assign 

departments to a location 

  

Reports Menu 
Previews and prints up to 36 reports; you can also access this list and select a report by clicking 
Reports on the left Feature Column. 
  

Help Menu 
• Contents– Brings up the Help File 
• Checklist– Displays Checklist screen that helps you set up the program  
• Check For Updates– Checks for any new updates 
• Auto Updater Settings – Allows you to enable the auto-updating feature. 
• System Information– Displays database information and current users 
• About– Displays program version number and current license 
• Alter Current Product License– Allows you to enter/edit product key code 



Using Gradience Records 

  
Gradience Records is now easier to navigate than ever before. Even better, if you have other 
Gradience software installed, such as Gradience Attendance and TimeClock, you have access to 
all programs and features from one convenient interface. 
 
The main parts of the Gradience user interface are the Menu Bar, Program Bar, Feature Column, 
Employee Select Column, Selected Feature Pane. 
  



The Program Bar 
The Program Button in the upper-left corner allows you to select the Gradience program you 
wish to use and displays its features in the Feature Column. 
 
The programs are color coded as follows: 
 
Gradience Attendance 2008 –Green 
GradienceRecords 2008 –Red 
Gradience TimeClock 2008 –Purple 
  

  



The Feature Column 
 
 

TheFeature Column allows you to select which feature will be displayed in the Feature Pane on 
the right side. To make it easier, we also color-coded the features of each program. For example, 
if you select Gradience Records, and select Employee Detail from the feature column, you will 
see a red title bar. 
The Employee Select Column 
The Employee Select Column allows you to select or find employees quickly and easily, as well 
as select multiple employees for printing reports. 
Browse mode allows you to perform an incremental search for an employee, move columns and 
sort quickly. 
An incremental search allows you to enter the first couple of letters of the employees’ last name 
and will go to the first employee which matches those letters; and as you enter more letters, the 
search will become more defined. For example, if you enter the letter “A” in the Search field, the 
employee list will select the first employee name which starts with the letter “A.” If you enter the 
letter “d,” so that now you have “Ad” it will bring up the first employee name which starts with Ad, 
such as Adams. 
You may move columns according to your preferences. To move a column, click and drag the title 
to the left or right. Double arrows pointing inward will show you where you will drop the title if you 
release the mouse button. 
Sorting fields is just as easy. Just click on the title of the column you want to sort. For example, if 
you wanted to sort by first name, you would click on the First Name title. You can also set 
multiple sorts by holding the CTRL key and clicking on fields - the sort priority will be displayed 
above the field names. 
Tree View mode allows you to find or select employees by location and department. For 
example, if you were looking for employees who are under the Ft. Lauderdale location / 
Merchandising department, Tree View mode could show you at a glance. 
Tip: In Tree View, by default all locations and departments are unchecked. A quick way to select 
just one department is to click on the name of the department. This will select all employees 
under that department. Likewise, in Browse mode, you can select or deselect all employees by 
clicking on the red checkmark at the top left. 
Selected Feature Pane 
The Feature Pane is where the selected feature of the program will be displayed.  
  
Note: Columns can be resized. To resize a column, move your cursor to the left or right edge of 
the column until your cursor turns into a double arrow pointing left and right; click and drag your 
left mouse button to the desired width and release. The Employee Select Column can also be 
hidden and unhidden by clicking on the minus or plus sign in the top right corner. 



Accidents Feature 

  
The Accidents Feature allows you to document on-site accident information as required by 
OSHA. This Feature in Gradiencecomplies with OSHA's Form 301 and must be completed within 
7 calendar days after you receive information that a recordable work-related injury or illness has 
occurred. The information must be kept on file for five years following the year to which it 
pertains, in accordance with Public Law 91-596 and 29 CFR 1904 (OSHA's Recordkeeping Rule). 
There are many data fields that should be completed with each new incident. To add a new 
accident record, click New and fill in all applicable blocks. Click Save to keep changes. To delete 
a record, click Delete. 



Benefits Feature 
Benefits are important to all employees. On this screen, you can enter all of the information for 
the benefit plans your company provides. This screen will allow you to track benefits such as 
401(k), COBRA, FMLA, dental, medical, life insurance, disability and others. 
  

Benefits Description 

  
Benefit Name  Description 
401(k) Plan  Employee savings and retirement plan, usually deducted pre-tax from 

salary, designed to reward employees for their service and to provide 
a source of income upon retirement, disability, death and/or 
termination of employment. 

AD & D Dependent Accidental death and dismemberment Dependent coverage. Usually 
has a maximum benefit. This may be company-sponsored. 

AD&D Self  Accidental death and dismemberment coverage. Usually has a 
maximum benefit. This may be company-sponsored. 

COBRA  Federal law requires companies of 20 or more employees to continue 
availability of health coverage for specific periods of time. (Your state 
law may also have provisions.) 

Credit Union Financial institution that may offer special financial services such as 
low-interest credit cards, direct deposit and a variety of loans to 
members. 

Dental-Dependent Dental insurance coverage for employee’s dependents. 

Dental-Self Dental insurance coverage for employee. 
Life Insurance Employee life insurance, usually has maximum benefits. 
Major Medical – Dependent Hospitalization for employee’s dependents. 

Major Medical-Self Hospitalization for employee. 

Medical-Dependent Medical insurance for employee’s dependents. 

Medical-Self Medical insurance for employee. 
Pension Retirement plan. 
  



Education Feature 
The Education Feature allows you to record information about an employee’s educational 
background. 

• School – Name of the school 
• Degree – Select a degree or certification from the drop-down list (see the Schools button 

for information on adding to the list) 
• Graduated – Employee's graduation status 
• Date Graduated – Enter a date or click on the drop-down arrow to select a date 
• Comments – Enter comments regarding education 

  
Click New to create a new record and fill in all applicable blocks. Click Save to keep changes. To 
delete a record, click Delete. 
  
To add to the School or Degree list, go to Settings, General Codes, and click on Education 
School or Education Degree. You may also enter the Seminar, School or Certificate name on 
the screen. Only names that have been entered through the General Codes screen will appear on 
the drop-down box. 
  



EEO/OtherFeature 
This option is for tracking EEO information as required by the Equal Employment Opportunity 
Commission. This information should be kept confidential and used strictly for EEO reporting 
purposes. Each EEO field is described below: 
EEO 

• EEO Category:Select the appropriate category for the employee. 
• Date of Birth:Enter the employee's birth date. 
• Sex:Select Male or Female. 
• Race:The select item most appropriate for the employee’s race. 

• Apprentice:Check the checkbox to indicate the employee is an apprentice. 
Note: The provided categories and race selections are taken from the official EEO categories as 
defined by the EEO commission. You may not create other categories. This program is updated 
periodically for FREE. If the government authorizes a new EEO category or authorizes that an 
existing category be changed, we will offer this revision in an update. 
Other 
The following items are miscellaneous information that you may choose to store about each 
employee: 

• Clearance Level:This field would generally be used for a security clearance. For example, 
some government contracts may require your employees to have a security clearance, 
such as Top Secret, Secret, Classified, etc. If your organization doesn't have a need for 
this information, you could use this field for other purposes like whether or not this 
employee has authorization to enter the building after hours, etc. 

• Clearance Date:This field would generally be used for storing the date that a security 
clearance was granted. This field is optional and can also be used for other dates as you 
see fit. 

• License:This field is optional and can be used to store a license number if appropriate for 
your type of business. 

• Veteran Status:If your business has a need to track an employee's veteran status, select 
the appropriate veteran status for the employee.  

• Martial Status:Select the marital status of the employee. 
  
Note: The provided categories and race selections are taken from the official EEO categories as 
defined by the EEO commission. You may not create other categories. This program is updated 
periodically for FREE. If the government authorizes a new EEO category or authorizes that an 
existing category be changed, we will offer this revision in an update. 
  

I-9 

• Verified:Is the employee verified for I-9 Renewals? 
• Renewal Date:Select the date for Renewal. 

  



Employee Detail Feature 
The Employee Detail Feature is the main data entry and viewing screen for employee 
information. It is shared between the Gradience versions of Records, Attendance and TimeClock. 
If only one program has been installed, the features for the others will not be seen. The screen is 
divided into two sections, the browse and tree view on the left, and the main data entry screen on 
the right. 
  
Note: Pictures are assigned to an employee through the Edit Picture button under the Personal 
Contacts or Employee Detail Feature. 
  

• Salutation:Select Mr., Mrs., Ms., as appropriate; this field is not required. 
• First:Enter employee's First Name. 
• Middle:Enter the first letter for the employee's Middle Name (Middle Initial). 
• Last:Enter the employee's Last Name. 
• SSN:Employee's Social Security Number (or other National ID as selected under Global 

Preferences, General Settings) 
• ID:Enter a unique ID for the Employee. 
• Hire Date: Enter the date the employee was hired. If the employee has been hired more 

than once, you should enter the last (most recent) hire date. 
• Work Status: Select Full Time or Part-time as appropriate. 
• Employment Status: Select Active, Inactive, or Terminated to show the employee's 

status. 
• Type: Select Regular or Seasonal  
• Job Title: Enter the employee's current Job Title. 
• Location: Select the location at which the employee is primarily employed. 
• Department:Select the Department that the employee is currently assigned to. 
• Day Hours: Enter the number of hours the employee will work in a typical workday. 
• Week Hours: Enter the number of hours the employee will work in a typical workweek. 

 
• Hide Picture: Click in this box to hide the assigned picture. To assign a picture, see the 

Edit Picture button under the Personal Contacts Feature. 
• Supervisor:Enter the employee's Supervisor. 
• Position code: Enter the employee's position code. 
• Recruiter: Enter the employee's recruiter. 
• Source of Hire: Enter the employee's source of hire. 
• Comments: Enter any comments about the employee. 
• Edit Picture: Remove or Assign a picture for the employee. 

  

Adding a New Employee 
1. Click the New button. 
2. Enter the Required Fields. (You can use the TAB key to move from field to field or hold 

down the SHIFT key and press TAB to move back a field.) 
• Required Fields - 
• First and Last Name 
• Hire Date 
• Work Status 
• Employment Status 
• Location 
• Department 
• Hours(Day and Week) - This is the amount of hours an employee works for a typical 

workday and workweek. These numbers are used as defaults when generating 
report totals. 



Performance Feature 
The Performance Feature allows you to schedule and track performance reviews, as well as 
document employee skills and achievements. Several new areas of information have been added 
to this feature for Gradience Version 9, plus you can now attach supporting documentation files to 
comments fields. 
  

• Interviewer – Name of the person conducting the review 
• Review Date – Date of performance review 
• Reason – General reason for review (annual, 3 month, etc.) 
• Overall Rating – If applicable, the total score of the review 
• Next Review Date – Date of next performance review 
• Increase% – Amount of salary increase due as a result of the interview 
• Comments – Allows you to enter comments or attach supporting documents (e.g., in 

Microsoft® Word) regarding the logistics of the review 
• Major Strengths – Allows you to enter comments or attach supporting documents 

(e.g., in Microsoft® Word) regarding the logistics of the review 

• Areas Needing Improvement – Allows you to enter comments or attach supporting 
documents (e.g., in Microsoft® Word) regarding the logistics of the review 

• Additional Comments – Allows you to enter comments or attach supporting documents 
(e.g., in Microsoft® Word) regarding the logistics of the review 

• General Ratings – Lets you rate employee (Outstanding, Very Good, Good, Improvement 
Needed, Unsatisfactory or Not Applicable) for various attributes: 

• Quality 
• Productivity 
• Job Knowledge 
• Reliability 
• Attendance 
• Independence 
• Creativity 
• Initiative 
• Adherence to Policy 
• Work Relationships 
• Judgement 

Note: There are separate comment fields for each attribute so that you can include a brief note or 
attach supporting documentation; for example, under Productivity, you might attach an Excel file 
that summarizes the amount of work an employee performs. 

• Goals / % Achieved– List up to five major goals the employee worked on during the last 
review period, plus assign a percentage to the amount of the goal that was achieved. The 
comments field for each goal allows file attachments. 

• New Goals / % Achieved–List up to five major goals the employee should work toward 
until the next review; you can periodically update the percentage achieved as you get 
closer to the next review. The comments field for each goal allows file attachments. 

• Comments– Here you can write any remaining notes concerning the review plus add file 
attachments. 



Personal Contacts Feature 

  

Recommendation: 
We recommend that you enter all of the relevant personal contacts for each employee before 
continuing. As you enter each personal contact you will be given the option of designating the 
new contact as an Emergency Contact. For each one designated as an Emergency Contact, you 
will have the option of selecting the “order” in which they should be contacted in the event of an 
emergency involving the employee.  

1. Click on Personal Contacts on the menu on the left side of the screen and then, click 
New and enter required data.  

2. To add a photo of the contact (perhaps required for security reasons) you should click Edit 
Picture. This will allow you to navigate to where the photo is saved. The photo must be no 
larger than 200 x 200 pixels. If it is larger than this it cannot be saved into the program. 
You would need to use a program like PhotoShop to reduce it’s resolution to 200 x 200 
pixels and then you will be able to bring it into the Records program.  

  

Later when you assign a benefit to an employee that will also cover dependent family members, 
the names entered here will appear as potential beneficiaries that may be selected.  
  

Adding an Employee Picture 
A photo gives you a visual image of an employee, their dependent(s) or emergency contact 
person(s). Photos are not required. We recommend you use a digital camera to take your photos 
and save the images in the industry standard JPEG (.JPG) picture format or Bitmap (.BMP) 
format. An image size of 200 x 200 pixels works best. If your picture is larger than this, the 
program will squeeze your larger picture into the displayed picture frame. If your digital camera 
has TWAIN support, you can import the picture right into Gradience using the Twain Import 
feature. 

To add an employee picture follow these steps: 
1. From either the Personal Contacts or Employee Detail Feature select the employee you 

want to add a picture to. 
2. Click Edit Picture. 
3. Click Assign New Photo. 
4. Navigate to where the employee picture is.  
5. Select it and click Open. If your photo is larger than the recommended size (200x200 

pixels), you may get a message that asks if you still want to assign the file. If you click Yes, 
the program will try to squeeze your larger picture into the frame, however, the larger size 
of the file will be maintained and may make the database larger. 

6. Click OK. 

Using Twain Import 
The Twain Import button allows you to import pictures directly from your Twain-compliant digital 
camera. You’ll need to install the software that came with your digital camera. To import a photo 
from your digital camera, follow these steps: 

1. First, you’ll need to make sure that your digital camera is Twain-compliant and that the 
software that came with your camera is installed on the same computer where you will run 
Gradience. 

2. Connect your digital camera to your computer. 
3. Open Gradience and navigate to the employee you want to add a picture to. 
4. Click on the Personal Contacts tab. 
5. Select the Edit Picture button and click on the Twain Import button. 
6. Click the Select Source button and then on your camera name. You may have one or two 

options available. 



1. [Camera Name]– This option allows you to take the picture and import it to 
Gradience. Go to Taking a Picture and Importing to Gradience below to continue 
instructions. 

2. Photos in [Camera Name]- This option will allow you to download and view the 
pictures on your camera’s disk if you’ve already taken pictures. Go to Downloading 
Pictures from Camera Disk below to continue instructions. 

Taking a Picture and Importing it into Gradience 

Continue following these steps from Step 6a above: 
1. After selecting your camera as the source, click OK 
2. Click the Acquire Picture button and click Take Picture. The picture should show up on the 

Twain Import screen. 
3. Click OK to select the picture. 

Note: The instructions for selecting or downloading a picture may be different depending on your 
camera. 
  

Downloading Pictures from Camera Disk 
1. Continue following these steps from Step 6b above: 
2. After selecting this option, click OK 
3. Click the Download button to download the pictures to your computer. 
4. Select the picture you want to import then click Transfer. 
5. Click Ok to select this picture. 

Note: The instructions for selecting or downloading a picture may be different depending on your 
camera. 
  

Saving a Photo to Disk 
All the pictures in Gradience are stored in the Gradience database (hrware.gdb). This option will 
allow you to save the picture to a different directory, if needed. 
To save an assigned photo to your computer, follow these steps: 
Note:The picture must be assigned to an employee before you can save it to a different directory. 

1. Click Personal Contacts, then the Edit Picture button. 
2. Click Save Photo to Disk. 
3. Navigate to where you want to save the photo. 
4. Name the photo. 
5. Click OK. The picture can only be saved as a .bmp file. 

Address Tab 
The Address Tab allows you to enter an employee’s contact information. 

When entering an address, verify which name you are adding the address to by looking at the 
relation and name just below the Address Tab (or above Address Type and Last Updated). As in 
the above screen shot, we would be adding contact information to the Employee, Neil Adams. 
Use the top set of arrows to scroll to another contact name for the selected employee. For 
example, if we clicked on the Next arrow, we would scroll through the contact list for Neil Adams. 
Use the bottom set of arrows to scroll though the Address Type (Home, Office, etc.). 
To enter address information for the selection Relation, follow these steps: 

1. Click on the New icon. 
2. Enter the contact information, filling out as much information as needed. These fields are 

not required. 
3. Click the Save icon to accept changes. 
4. Click the Cancel icon to discard any changes. 
5. Click the Delete icon to delete an address record. 



Reminders 
   

The Reminders feature will show you all open (unresolved) reminders and allow you to create, 
delete and resolve reminders. If you have created a reminder, it will show up when you first open 
the program, starting on the reminder date. Reminders will continue to display until you click 
Resolved.  
   

Reminders Tool Bar and Pane Layout 
       

Tool Bar: 
First — Prior — Next — Last arrows – Navigates through selected reminders 

New – Creates a new reminder 
Edit – Allows you to make changes to a reminder 

Save – Saves reminder 
Cancel – Cancels current changes 

Delete – Deletes selected reminder 
Print – Lets you print the Reminders report for selected employees 
Help – Brings up help for this screen 

   

Pane Layout: 
Reminder Date – Date reminder should first display 
Title – Heading of reminder 

Resolved – Checkbox displays checked for resolved or unchecked for open (unresolved) 
Employee Name – Displays name of employee that reminder is associated with 

User – Displays name of user that reminder will display for 
Description – The purpose of the reminder shows here 

   

Filters: 
User – Allows you to view reminders associated with specific users (must have access to 
Reminders, Assign Users under User Security) 
Show Resolved – Displays Resolved reminders only 

Show Unresolved – Displays Unresolved (open) reminders only 
   

Creating a New Reminder 
   

There are two types of reminders in Gradience:  

• One Time Reminders – These are reminders that are meant only to remind you of a one-
time event, such as: 
• Filing an Absence Report at the end of the year.  

• Recurring Reminders – These remind you of the following recurring events:  
• Anniversaries (Gradience Attendance) 
• Birthdays, Performance Reviews, and I-9 Renewals (available if Gradience Records is 
also installed) 

   

Setting a Reminder 
   

One-Time Reminder: 
1. Click on Reminders from the Features Column.  
2. Click New.  
3. Select (check) One-Time Reminder.  
4. Enter a Title and Reminder Date 



5. If you want the reminder to be associated with specific employees, select the checkbox, 
“Assign to all selected (checked) employees.” This is optional and will create a separate 
reminder that is associated with each employee.  

6. If you selected the checkbox in Step 5, you will need to select (check) any employees this 
reminder is about in the Employee Select Column. Otherwise, skip to the next step.  

7. By default, the User’s name will default to the login that was used to enter the program. 
Change this if you want the reminder to come up for another user, or you may select 
Global, which allows the reminder to come up for all users logging in.  
Note: You must have access to Reminders, Assign Users and Reminders, Assign Global 
under User Security to be able to change this option.  

8. Enter a description of the reminder, if needed. 
9. Click Save. 

Recurring Reminder 
1. To create a recurring reminder, follow these steps: 
2. Select Reminders from the feature list. 
3. Click New. 
4. Select (check) Recurring Reminder. 
5. Select the type of reminder: Anniversary, Birthday, Performance Review or I-9 

Renewal. 
6. Select a Through Date (when do you want to stop the reminder from occurring). 
7. Select how many days you want to be reminded before the event. 
8. By default, the User’s name will default to the login that was used to enter the program. 

Change this if you want the reminder to come up for another user, or you may select 
Global, which allows the reminder to come up for all users logging in.  
Note: You must have access to Reminders, Assign Users and Reminders, Assign Global 
under User Security to be able to change this option. 

9. Enter a description of the reminder, if needed. 
10. Click Save. 

Deleting Reminders 
   

Reminders are deleted from the Main Reminders screen by clicking on the Delete icon.  
   

Editing Reminders 
   

There are two ways to edit reminders:  
1. Main Reminders screen - From the main Reminders screen, you can edit the following 

columns just by clicking in the field: Reminder Date, Title, Resolved and Description. 
2. Edit Reminders screen - Clicking on Edit from the main Reminders screen will bring up 

the Edit Reminder screen. You also may double-click on the title of a reminder. The Edit 
Reminders screen allows you to change the Title, Reminder Date, User and Description. 

Note: If you need to change the Employee Name this reminder is about, you’ll need to delete 

the reminder and then recreate it.  

   

Open Reminders 
   

Open reminders will appear for the user they are assigned unless the Global option is checked. If 
a reminder is marked with Global, then it will show for all users. You may view open reminders by 
opening the program or selecting Reminders from the feature list.  
   
Note: If you have security access to “Reminders, Assign Users” (see User Security), you may 
view reminders set up by other users. You also may resolve reminders from the Open Reminders 
screen.  



   

   
   
   
   

   
   
   



Reports 
Gradience Records creates many reports and charts that relate to employee record keeping. For 
additional reporting capability, please try Gradience Attendance, which offers you the power to 
track absenteeism and time-off benefit balances. 
  

Creating and Printing Reports 
There are two ways to preview and print a report. 

1. You may preview and print from the individual feature by clicking on the Printer icon 
associated with that feature or 

2. You may go to the Reports drop down menu or feature list for more sorting/filtering 
options. 

Printing from the Reports Feature or Menu Bar 
1. From the Employee Select column, select which employees you want to report on; you 

may use either the Browse mode or TreeView mode to select employees. 
2. From the feature list, click Reports and then choose a report. 
3. Select sorting / filtering options in the Feature Pane, if needed, and click Preview. 
4. Click the printer icon to print. 

Each report has basic and additional options for that specific report. 

  



Separation Feature 
The Separation Feature allows you to document employee separations properly, which can be 
very important if the separation is a termination. This documentation could serve as evidence at 
an unemployment compensation hearing or if an employee levels allegations of discrimination.  
   

• Comments – Use this field to document the events of the separation meeting: what was 
said, behavior of the employee, etc. You can also include file attachments in this field. 

• Reason for Separation – Select a reason from the drop down list; there are many default 
choices, but you can also customize this list through Settings, General Codes, Separation 
Reasons. 

To add more reasons and separation types to the drop-down list, go to Settings, General Codes. 
Click New to record a new record. Click Save to keep changes. Click Delete to delete a record. 



Taxes Feature 

The tax screen can be used to record an employee's exemption and filing status. This information 
is usually found on the employee's W-4 form.  

• Number of Dependents – Dependents may be children, spouse, parents or other.  
• Number of Federal Exemptions – This is the number of exemptions that an employee is 

claiming.  
• Additional Amount Withheld – Any additional amount withheld from an employee’s 

paycheck.  
• Federal Tax Withheld – Amount of Federal tax to be withheld from an employee’s 

paycheck.  
• Effective Date – Date of changes made to the employee’s family status or the initial hire 

date.  
• Other Taxes – This allows you to indicate if other types of taxes are paid.  
• Filing Status – This allows you to enter the employee's filing status. Full  
• Full-time Student – If the employee meets the requirements to be classified as a full-time 

student, you may check this option.  
• Comments– This allows you to enter additional tax-related notes.  



Training Feature 
The Training Feature allows you to track seminars, certifications and courses. 

• Seminar– Name of the seminar 
• School– Name of the school 
• Certification– Name of the certification 
• Certification#– Certification number 
• Employer Cost– How much the company paid for the training 
• Employee Cost– How much the employee paid for the training 
• Begin Date– Starting date of training 
• End Date– Concluding date of training 
• Expiration– Expiration date of training, if applicable 
• Mandatory– Select if mandatory 
• Completed– Select if employee completed the training 
• Comments– Enter notes regarding training, plus file attachments 

  
To add a new training record, click on New and fill in all appropriate fields. You may also enter 
the Seminar, School or Certificate name on the screen. Only names that have been entered 
through the General Codes screen will appear on the drop-down box. 
  
To add to the list under Seminar, School, or Certification, go to Settings, General Codes and 
click on Training Certificate Names, Training School or Training Seminar. Click New and make an 
entry. Click Save. To delete a record, click Delete. 



Wages Feature 
Use the Wages Feature screen to track employee salaries and wage histories. 

• Reason for Change – The Reason for change in wage amount (merit increase, length of 
service, etc.) 

• Effective From – Date of pay change 
• Effective To – Date of next review 
• Department – Enter new department, if applicable 
• Job Title – Enter new title, if applicable 
• Pay Frequency – Frequency that employee is paid 
• Rate – Employee's pay rate 
• Hour Rate – Amount earned hourly. 
• Annual Rate – Amount earned yearly. 
• Maximum – Pay range (high end) 
• Minimum – Pay range (low end) 

• Hours – Choose Full or Part Time, and if work for the employee is Educational, 
Seasonal and/or Temporary. 

• Exempt – Indicates exempt status. An employee is considered exempt if pay is 
determined on a salary basis. An non-exempt employee is paid by the hour. 

• Comments – Enter additional wage related information, as well as attach any supporting 
file. 

Click New to create a new wage record and fill in all applicable blocks. Click Save to keep 
changes. To delete a record, click Delete. 



Warnings Feature 
The Warnings Feature allows you to record disciplinary action, which protects employers in the 
event there’s a dispute, especially if repeated warnings formed the basis of serious employee 
sanctions (e.g., suspension, demotion or termination). 

• Date and time of incident – Date and time of the employee’s unacceptable behavior or 
incident 

• Date of Warning –The date that the employee received the warning 
• Interviewer – Identify the individual giving the warning 
• Warning Type – Select the reason for the warning, as defined under Reason Codes under 

the Settings menu 
• Comments – Enter additional information regarding this warning, including file 

attachments that could provide supporting evidence. You can also note any other persons 
who witnessed the incident or presentation of the warning. 

• Notification – Select the type of notification, either verbal or written. Gradience 
recommends employers always give warnings in written form, with both the Interviewer 
and Employee providing signature and date. 

• Action Taken – Select the type of action that was taken: 

• Warning only 
• Probation 
• Suspension 
• Dismissal 
• Other (Specify in Comments field) 

• Signed Copy By Employee / Supervisor – As noted above, a signed hardcopy of the 
warning by both employee and supervisor is best. Check here to verify this important step 
was taken. 

• Consequences should the incident occur again – Note here what the employee should 
expect should the incident be repeated. The most broad statement would be “Disciplinary 
action up to and including termination.” 

  
To add additional Warning Types, go to Settings, General Codes and click on Warnings. Click 
New to record a new record. Click Save to keep changes. Click Delete to delete a record. 



Types of Available Reports 

Employee Reports 
• Accidents Report – Track and report on employee Accidents. 
• Performance Report – Track and report Employee Performance details. 
• Detail – The Employee Detail Report produces a detailed report of each employee's 

primary information. Plus, their Supervisor, Job Code and Recruiter. 
 

• Summary – The Employee Summary Report produces a summary report of each 
employee's primary information. 

• Training – Training Report #1. The Employee Training Report produces a record of training 
sessions attended by all employees. 

• Training Extended – Training Report #2. The Training Extended Report produces a training 
report on legal size paper to fit more information. 

• Education – The Employee Education Report produces a record of educational institutions 
attended by an employee. Degrees and certifications are included in this record. 

• Reminders – The Employee Reminder Report produces a listing of all open reminders 
sorted by reminder date. 

• Separations – The Employee Separations Report documents reasons for separations. 
• Warnings – The Employee Warnings Report produces a printed record of all employee 

warnings occurring within a specified date range. 
• Dependents – The Employee Dependents Report produces a report of employee 

dependents. 
• Emergency – The Employee Emergency Report produces a report of emergency contact 

information for employees. 
 

  

Date Reporting 
• Anniversary – The Anniversary Report produces a list of employees whose hire dates fall 

within a specified date range. 
• New Hires – The New Hire Report produces a list of employees hired within a specified 

date range. 
• Birth Date – The Birth Dates Report produces a list of employees whose birthdays fall 

within a specified date range. 
• Seniority – The Seniority Report produces a list of employees by hire date, from the 

earliest to latest hire date. 

  

Salary Reports 
• Ranking/Analysis – The Salary Ranking/Analysis Report produces a list of employees 

ranked by salary. 
• History – The Salary History Report produces a list of all employee salary changes. 
• Tax Settings – The Tax Settings Report produces a report of employee’s tax information. 

Benefits Report 
• The Benefits Report produces a listing of each employee’s benefit status. 

  

Performance Reports 
• Review History – This report is useful for department managers to schedule and prepare 

for upcoming reviews. It shows selected employee’s next, last and overdue review dates, 
increases and ratings. It can be sorted by location, department and by date of last review. 

• Review Schedule – This report produces a listing of performance review records. It shows 
each employee’s next review date, job title, hire date, and last review date. It can be 
sorted by location, department, and by date of next review. 

• Review Detail – Provides actual reviews that have been performed. 



  

Government Reports 
• EEO Detail – The Equal Employment Opportunity (EEO) Detail Report shows the data 

used to compile the EEO Summary Report. This report shows the employee name, title, 
full-time/part-time, status, hire date, sex, EEO, category and ethnic code. 

• EEO Summary – The Equal Employment Opportunity (EEO) Summary Report shows each 
of the five U.S. Government defined race classifications broken down by EEO 
classifications (from the EEO categories table). EEO Categories are job classifications 
such as Sales Workers, Craftsman, Professional, etc. 

• COBRA – The COBRA Report produces a listing of important COBRA dates for all 
employees and their dependents if applicable. This report shows the date the employee 
was notified about COBRA benefits, if the employee accepted, when benefits end and the 
ending COBRA coverage date. 

• I-9 Renewals – The I-9 Renewals Report produces a listing of upcoming renewal dates for 
employees to resubmit their government I-9 form. It shows each employee’s name, title, 
hire date and I-9 renewal date. 

• Accident Report – The Accident Report produces a listing of all reported accidents that 
occurred within a specified date range. 

• Accident Detail – The Accident with OSHA report produces a listing of all reported 
accidents that occurred within a specified date range. 

  

Telephone List 
The Telephone List Report produces a record of all employee phone numbers. You can print 
office phone number with extension number, office extension only or home phone number. 

  

ID Badges 
This feature enables you to print employee ID badges with photos. 

  

Labels 
This report enables you to print mailing labels for employee mailings. Records supports three 
different Avery label formats: 
Avery 5160 3x10 (2.63’’ x 1”), Avery 5261 2x10 (4’’ x 1’’) and Avery 5262 2x7 (4’’ x 1.33’’). 

Gradience Records now enables you to adjust the position of your labels. On the Label Report 
screen there are two options:Left Offset and Top Offset. Adjust the position of your labels using 
these two options. 

  

Charts 
• Salary Breakdown– The Salary Breakdown Chart allows you to view salaries broken down 

in a pie chart, bar graph, line or point chart format. 
• Ethnic Codes –The Ethnic Codes Chart allows you to view race categories broken down in 

a pie chart, bar graph, line or point chart format. 
• EEO Category Breakdown – The EEO Categories Chart allows you to view race 

categories broken down in a pie chart, bar graph, line or point chart format. 



Charts – Report Interface 

  
Charts allow you to view Salary Breakdown, Ethnic Codes, and EEO Category Breakdown 
information. 
Charts can help you view information at a glance. Using the charts, you can view these charts: 

• Salary Breakdown – Enables you to view and compare salary breakdown. 
• Ethnic Codes Breakdown – Enables you to view your companies race breakdown. 

• EEO Category Breakdown – Enables you to view your companies EEO category 
breakdown. 

Follow the steps here to print a chart: 
1. Click Reports from the main menu, select Charts; then select the Chart you wish to use. 
2. Select the Options you want. 
3. Click Run Graph.The chart control window will appear. 
4. The selections here will affect the chart as it is shown on screen. Select the options you 

want and click the Preview & Print icon to see how the chart will appear. 
From the Preview screen, click the Printer icon to print the chart. 
When you click on Run Graph you will have the following options: 

• Preview & Print – This shows a preview of the chart. 
• Close – Exits the Chart screen. 
• Help – Brings up Help pertaining to this screen. 
• Chart Type – Gives you the choice of viewing as a Pie, Bar Graph, Line, or Point Chart. 
• Color assignments – This allows you to set the colors of a specific month. 
• Display – Toggles the Legend (data box next to the chart), Parameters (data at the bottom 

of the chart), and Ignore Zeros (any data on the chart with zeros). 
• Label Display – Toggles the Label only (months), Value only (see Value Display), or Label 

and Value. 
• Value Display – Toggles the value as a number (count), percentage, or Percentage Of 

(shows as: [percentage] of [total count]). 
• 3-D Control – This allows you to view the depth of 3-D by moving the arrows. 
• Rotation – Rotates the Pie Chart in the desired direction. 
• Explode Biggest – Moves the largest piece away from the pie. 



Accident Detail Report 
The Accident Detail report prints all accident information that occurred within a specified date 
range for each employee selected. 
  

Additional options for this report: 

• Injury Date: From/Through – This allows you to view all injury dates. 
• Date Reported: From/Through – This allows you to filter by date reported. 

  



Accident Report 

  
The Accident Report produces a listing of all reported accidents that occurred within a specified 
date range. 
  

Additional options for this report: 

• Employee – Employee name. 
• Case Number – Assigned case number. 
• Injury Date: From/Through – This allows you to view all injury dates. 
• Date Reported: From/Through – Date reported from and through. 

 
• Incident Occurrence – How incident occurred. 

 
• Days Off – How many days the employee was off work. 
• Return Date – Return to work date. 



Anniversary Report 
The Anniversary Report produces a list of employees whose hire dates fall within a specified date 
range. 
Additional options for this report: 

• From Date/To Date – runs the anniversary report according to this date range 



Basic Report Options 
Each report has the same Menu, Grouping and Export options: 
  

Report Menu Options 
• Preview – Displays the report with options to print and setup printer. 
• Print – Sends the report to the selected printer. 
• Custom – Allows you to customize a report. 
• Help – Displays help pertaining to this screen. 

Grouping Options 
• Location – Groups data by Location. 
• Department – Groups data by Department. With Location also selected, the report will 

group by location, then department. 
• Show Group Totals – Shows total number of employees after Location and/or Departments 

with a grand total at the end of the report. Location and/or Department must be selected 
for this option to be enabled. With both Location and Department unselected, the report 
will group by Last Name in alphabetically order. 

Display Options 
• Show Social Security Number on Report – This allows you the option of displaying the 

SSN on reports that include this data field. 
  
Alert for former Optima Users: Options for selecting only Active, Inactive or Terminated 
employees no longer appear within the Report Options Pane. However, if you do need sort by 
employment status, you can do so through the Sorting/Filter Page under the View menu. 



Benefits Report 
The Benefits Report produces a listing of each employee’s benefit status. 

Additional options for this report: 

• Eligible Date – Shows Benefits with an Eligible Date within selected date range 
• Joined Date – Shows Benefits with a Joined Date within selected date range 
• Withdrew Date – Shows Benefits with a Withdrew Date within selected date range 
• Waived Benefits Only – Shows Benefits with a Waived Benefits date within a selected date 

range 
• Report Only Selected Benefit(s) – With this box checked, it allows you to select one or 

multiple benefits to report on 



Birth Date Report 

  
The Birth Dates Report produces a list of employees whose birthdays fall within a specified date 
range. 
Additional options for this report: 

• Filter Settings – runs a birthday report within a certain date range. 



COBRA Report 

  
The COBRA Report produces a listing of important COBRA dates for all employees and their 
dependents if applicable. This report shows the date the employee was notified about COBRA 
benefits, if the employee accepted, when benefits end and the ending COBRA coverage date. 
  

Additional options for this report: 

• Employer EndingDate – Shows employers ending COBRA date 
• COBRA Ending Date – Shows COBRA ending date 
• Notification Date – Shows employee notification date 



EEO Detail Report 
The Equal Employment Opportunity (EEO) Detail Report shows the data used to compile the 
EEO Summary Report. This report shows the employee name, title, full-time/part-time, status, 
hire date, sex, EEO, category and ethnic code. The EEO Detail report is a great report for 
auditing purposes. It gives specific EEO information including Employee Name, Title, Full or Part-
time, Active status, Date of Hire, Sex, Race and Category. 
  

Additional options for this report: 

• Employed During: From/Through – Reports on employees employed during a selected 
date range 

• Separation Date: From/Through – Employed During must be selected before this option 
will be available. Reports on employees separated during a selected date range. 

• Sort By Hire Date – This allows you to sort data on report by Hire Date 
• Sort By Separation Date – This allows you to sort data on report by separation date 
• Sex – This allows you to sort by Male or Female 
• Select Specific Race – This allows you to sort by multiple selected races. Click in the box 

next to Select Specific Race to be able to select specific races. 
• Select Specific Category – This allows you to sort by multiple selected categories. Click in 

the box next to Select Specific Category to be able to select specific categories 



EEO Summary Report 

  
The Equal Employment Opportunity (EEO) Summary Report shows each of the five U.S. 
Government defined race classifications broken down by EEO classifications (from the EEO 
categories table). EEO Categories are job classifications such as Sales Workers, Craftsman, 
Professional, etc. The EEO Summary is another great report for auditing purposes. It gives 
specific Race totals by Category. 
  

Additional options for this report: 

• Employed During: From/Through – Reports on employees employed during a selected 
date range 

• Separation Date: From/Through – Employed During must be selected before this option 
will be available. Reports on employees separated during a selected date range. 

• Select Specific Racee – This allows you to sort by multiple selected races. Click in the box 
next to Select Specific Race to be able to select specific races. 

• Select Specific Category – This allows you to sort by multiple selected categories. Click in 
the box next to Select Specific Category to be able to select specific categories. 



Employee Dependents Report 

The Employee Dependents Report produces a report of employee dependents. 
  

Additional options for this report: 

• Show Social Security Number on Report – toggles on or off the SSN 



Employee Detail Report 

  
The Employee Detail Report shows pertinent employee information including accrual plan 
assignments, balances, initial balances, Supervisor, job code, recruiter and notes from the 
Employee Detail Feature. 
  

Additional options for this report: 

• Show Social Security Number on Report – allows you to toggle on or off the SSN on this 
report. 

• Print Picture – allows you to toggle on or off the assigned employee picture on this report. 



Employee Education Report 

  
The Employee Education Report produces a record of educational institutions attended by an 
employee. Degrees and certifications are included in this record. 
  

Additional options for this report: 

• Degree Date – filters when an employee received his or her degree 



Employee Emergency Report 

  
The Employee Emergency Report produces a report of emergency contact information for 
employees. 
  

Additional options for this report: 

• Show Social Security Number on Report – toggles on or off the SSN 



Employee Reminders Report 
The Employee Reminder Report produces a listing of all open reminders sorted by reminder 
date. 
Additional options for this report: 

• Sort Options – Sorts by Date, Name, Topic or User Name 
• Reminder Date – Selects the date range of reminders to display 

 
 

Additional Filters 

• User – Shows reminders assigned to selected user 
• Display All Users – Shows reminders for all users 
• Show Resolved – Shows resolved reminders 
• Show Unresolved – Shows unresolved reminders 
• Show Global Only – Shows reminders assigned as Global 

  



Employee Separations Report 

  
The Employee Separations Report documents reasons for separations. 
  

Additional options for this report: 

• Separation Date – Filters on separations within this date range 

  



Employee Summary Report 

  
The Employee Summary Report shows an employee’s date of hire, title, status and work status. 
Use this report when you want an employee listing. 

  



Employee Training and Training Extended Report 

  
Training Report: The Employee Training Report produces a record of training sessions attended 
by all employees. In contrast, theTraining Extended Reportproduces a training report on legal 
size paper to fit more information. 
  

Main options: 

• Training Date Filters 
• Begin Date – select a beginning date for training 
• End Date – select training ended through this date 
• Expiration Date – select an expiration date for training 

  

Additional Filters 

• Mandatory – filters on training marked as mandatory 
• Completed – filters on training marked as completed 
• Select Seminar – filters on a specific seminar 
• Select School – filters on a specific school 
• Select Certification – filters on a specific certification 

  

Additional Options: 

• Grouping Options – By checking these boxes, you can group your report by 
Location,Department, or by (Show)Group Totals. 

• Show Social Security Number on Report - Displays the employee SSN on reports.  
• Include Images for Custom Reports – Check this box if you want to include images 

when creating or printing your custom reports. 
  



Employee Warnings Report 
The Employee Warnings Report produces a printed record of all employee warnings occurring 
within a specified date range. 
  

Additional options for this report: 

• Warning Date – filters on warnings given within this date range 

• Show Comments – displays comments on Warnings report. 

• Show Consequences – displays consequences on Warnings report. 
• Grouping Options – By checking these boxes, you can group your report by 

Location,Department, or by (Show)Group Totals. 
•  Include Images for Custom Reports – Check this box if you want to include images 

when creating or printing your custom reports. 



I-9 Renewals Report 

  
The I-9 Renewals Report produces a listing of upcoming renewal dates for employees to resubmit 
their government I-9 form. It shows each employee’s name, title, hire date and I-9 renewal date. 

  

Additional options for this report: 

• I-9 Renewal Date: From/Through– This allows you to view all I-9 Renewal dates 

  



ID Badges 

  
This feature enables you to print employee ID badges with photos and barcode. There are four 
types of ID Badges: Employee, Temporary, Guest or without a title. 
  

Additional options for this report: 
  

 Layout Tab: 
  

The Layout Tab allows you to select what features will be on the ID Badge. For example, if you 
want the badge title to read Guest instead of Employee you can select Guest under the Badge 
Title. 

• Printing Options: Print Title, Print Department, Print Employee ID Style 1, Print Employee 
Style 2, Print Location, Print Picture, Print Company Logo and Print Company Name 

• Badge Title – This allows you to print selected Title across Badge. 
• Name Format – This allows you to choose how the name will display on the badge. 

 

Barcode Tab 

  
The Barcode Tab allows you to select the type of Barcode that will be printed. If you’re not sure 
which type to use, we recommend keeping the default barcode type of Code 39. Gradience 
Records uses the Employee ID as the Barcode number. If an employee does nothave an 
Employee ID number (SeeEmployee Detail screen), a barcode will not print out on the label. 

• Print Barcode – This allows you to print a barcode across the bottom of the 
ID Badge. 

• Barcode Type – This allows you to select from popular barcode types. 



 

Print Stock Tab 

  
The Print Stock Tab allows you to select the label type. The Gradience ID Badge Kit (S0050) can 
be requested through our sales team and is specifically designed to work with Gradience Records 
and TimeClock. Each kit makes 25 badges. 
 
 

 
  

Label Adjustments Tab 

  
Printers are not created equally; some may print the labels too far to the right or left. The Label 
Adjustments tab allows you to move the labels to the left or right and up or down to accommodate 
quirky printers. Normally, you should not need to adjust the labels to the right and left, or up and 
down, but it’s there in case you need it. 

Feature Description 
Left Offset When using the Left Offset,positive numbers will offset the label to the right and negative numbers 



will offset the label to the left. 
Top Offset When using the Top Offset,positive numbers will move the labels down, and negative numbers will 

move the labels up. 
Picture Offset The Picture Offset allows you to stretch the picture by using positive numbers and negative numbers 

will squish the picture, if needed. 
Save Label 
Adjustment 

The Save Label Adjustments button allows you to save your current settings. 



Labels Report 

This report enables you to print mailing labels for employee mailings. Gradience Records 
supports three different Avery label formats and a number of other printing options: 
  

General Options: 

• Print Phone Number on Label 
• Print Names Only 
• Name Format (Last, FirstorFirst Last) 

 
Label size: – (you can only choose one size) 

• Avery 5160 (3 x 10 (1" x 2.625") 
• Avery 5261 (2 x 10 (1" x 42") 
• Avery 5162 (2 x 7 (1.333" x 4") 

 
  

Sorting Options: 

• Location 
• Department 
• Show Social Security Number 
• Include Images for Custom Reports 



New Hires Report 

  
The New Hire Report produces a list of employees hired within a specified date range. 



Performance Review History Report 

  
This report is useful for department managers to schedule and prepare for upcoming reviews. It 
shows selected employees’ next, last and overdue review dates, increases and ratings. It can be 
sorted by location, department and by date of last review. 

  

Additional options for this report: 
 

• Last Review Date – This allows you to report on dates of Last Review within selected date 
range 

• Grouping Options – By checking these boxes, you can group your report by Location, 
Department, or by (Show) Group Totals. 

• Include Images for Custom Reports – Check this box if you want to include images 
when creating or printing your custom reports. 



Performance Review Schedule Report 

  
This report produces a listing of performance review records. It shows each employee’s next 
review date, job title, hire date, and last review date. It can be sorted by location, department, and 
by date of next review 

. 
Additional options for this report: 
 

• Next Review Date – This allows you to report on dates of Next Review within selected date 
range 

• Grouping Options – By checking these boxes, you can group your report by Location, 
Department, or by (Show) Group Totals. 

• Include Images for Custom Reports – Check this box if you want to include images 
when creating or printing your custom reports. 



Salary History Report 

  
The Salary History Report produces a list of all employee salary changes. 



Salary Ranking/Analysis Report 

  
The Salary Ranking/Analysis Report produces a list of employees ranked by salary. 



Salary Tax Settings Report 

  
The Tax Settings Report produces a report of employee’s tax information 

  



Seniority Report 

  
The Seniority Report produces a list of employees by hire date, from the earliest to latest hire 
date. 

  



Table Listings 

  
Table Listings enable you to view and print out the following settings: 

• User Security (Summary) – Displays a list of everyone who has some level of access. 
• User Security (Detail ) – Displays in detail what level of access each person has. 
• Locations – This prints all locations. 
• Departments – This prints all departments. 
• Assigned Departments – This prints Locations with assigned departments. 
• General Codes – This prints the code listing from Settings, General Codes. 

Steps to print a Table Listings report: 
1. From the Reports menu, select Table Listings. 
2. Choose the Table Listings report you would like to run. 
3. Click Preview to view the report or Print to print out the report. 

4. In Preview mode click the print icon to send the report to your printer. 



Telephone List Report 

  
The Telephone List Report produces a record of all employee phone numbers. You can print 
office phone number with extension number, office extension only or home phone number. 
  

Additional options for this report: 

• Phone Number– Allows you to select which phone number to report on 

• Office Phones with Extension 
• Office Extension Only 
• Home Phones 

• Name Format– Allows you to select how to sort the employee names 
• Display Job Title– Allows you to toggle showing employee Job Title 

  



Custom Reports 

From any report feature (and after selecting filters and options such as Date ranges, Location and 
Department groupings, etc.), you can begin the process of creating a custom report. Custom 
Reports are a function of the FastReport™ engine built into Gradience. The purpose of this 
tutorial is to take you through the process for creating a custom report, editing some basic 
information inside FastReport, then showing you the outcome. For a full tutorial on working with 
FastReport, please see the FastReport documentation. 

Custom Reports give the user the option to present data from the original (template) report in new 
and exciting ways. How it works: The “default” Gradience report (called a “template” inside the 
application) is used as a base for the new custom report. The user always can start a new report 
from scratch, but it is usually easier to create a new report by modifying a copy of the original 
template. 

To create a custom report based on an existing report, you would click the Save As button and 
select a new name for the report. You then would proceed to edit the new “copy” of the report. To 
edit an existing report, select the report and click the Edit button. If you attempt to edit the 
“Default” report, a new name will be assigned automatically. 

To create a custom report, follow these steps: 

1. For this example, we will use the original Attendance Detail report as a template to create 
a new (custom) version of the report. Start by navigating to Reports > Attendance Detail.  

2.  Locate and click the Custom Report icon near the top right of the page.  
3. A new window titled Custom Reports – Attendance Detail will appear (shown below). As 

you can see, the current report name (in grayed-out text) is Attendance Detail Template.  

 



4. A Custom Sort can be selected by using the drop-down selection in the Custom Sort Fields 
section. Custom Sort Fields work by allowing you to select a field that will be used to sort 
the records on your custom report. Some built-in examples include LastName and 
EmployeeID, and ReportDefault appears as the default selection when you create your 
first custom report (you probably will want to change the default selection). Click Edit first, 
then click the (+) button to the right of the drop-down to edit a Custom Sort field or create a 
new one. 

5. A Custom Filter can be selected by using the drop-down selection in the custom filter 
section. Because you already have activated editing for items in this window, you can go 
ahead and click the (+) button to the right of the drop-down to edit Custom Filters or create 
new ones. 

6. By clicking the View Data button, you can see the results of any changes made to the sorts 
or filters. This can be very helpful when creating your own custom reports because you will 
be able to “preview” your report before you actually begin editing it in FastReport. 

 

7. After previewing your data, click Close in the viewer window to return to the Custom 
Reports window. 

8. If the report you wish to customize is not highlighted in the ReportName section, select the 
desired report now. 

9. Clicking New or Edit will bring you into the FastReport custom report designer. While in the 
designer, you will have the option to save the report as another name or save it to an 
external FastReport 3 (.fr3) file. You also will have the option to open a previously created 
FastReport file and save it in your database. See Help/Help Contents while in the designer 
for more information. 



 

10. Once you are finished editing your custom report in the designer, click File > Save, Save 
As or Exit to close the report to return to Gradience. 

Note: Tech Support does not offer training on Custom Reports. However, we can e-mail you a 
tutorial on Custom Reports free-of charge. To request a copy go to www.gradiencesupport.com 
and click on Ask a Question.  



Before Contacting Technical Support  

Please follow these guidelines before contacting Technical Support:  

• Remember, Gradience does not support setting up networks or computer configurations.  
• If you are having problems with your computer, try rebooting to see whether that corrects 

the issue. 
• If you are getting an error message, an access violation or encounter the software 

behaving in a manner that is unusual, go to the computer where the database is located 
and run the Database Maintenance. 
 
From the desktop click on Start > Programs (or All Programs) > Gradience > 
Maintenance > DB Maintenance. When the DB Maintenance window opens click on the 
Start button within that window. When it is finished, see if the issue that you are having 
with the software persists. Often this utility will resolve the issue. 

• If the issue is an error message and the Database Maintenance did not resolve it, please 
write down the whole message or take a screen print of it by clicking on the Print Screen 
key in the upper-right of your keyboard and then, paste it into MS Word or Wordpad or 
Notepad and save it to send in an e-mail to Tech Support later.  

• When communicating with Tech Support be ready to first indicate the “full” name of the 
software and the “full”, multi-digit version number of the program. You can find this by 
opening the program and clicking on Help and then clicking on About. A pop-up window 
will open that will indicate the “full”, multi-digit version number of the program. Sometimes 
the answer depends on this version number.  

• Indicate the steps that you took that lead-up to the problem that you have encountered.  
• Indicate whether you were able to run the Database Maintenance or not and whether it 

had any impact.  

  



Contacting Technical Support       

• Version 10 was introduced in November of 2007. We support the “current” version (10) 
and the “previous” version (9). A “Pro” license allows you to install it at one site and get 
support for that site. An “Enterprise” license allows you to install it at multiple sites and get 
support for each of those sites.  

• FREE phone support during the 30-day DEMO  
• FREE phone support for the first 30 days after you purchase the software  
• Technical support for by e-mail is ALWAYS FREE. Just go to www.gradiencesupport.com 

and click on:  
o Get Fast Answers to do a keyword search.  
o Ask a Question to request help from a Technical Support representative.  

Long-Term Phone Support 888-925-7740 (8:30 AM to 6:00 PM Eastern Time Monday 
through Friday except Holidays) 

• With a Maintenance Plan: One full year of phone support (not training) for technical 
issues and FREE software upgrades. For details call 800-999-9111 or 888-925-7740.  

• Without a Maintenance Plan: You will be charged $29.99 for each call to Tech Support.  
Assistance with understanding how to use the software 

• Professional Services: Get up to two hours of training and help setting up the software. 
For details call 800-999-9111 or 888-925-7740.  



Getting Help 

There are several ways to get help throughout the program.  
   



Sample Database  

A sample company (called a tutorial database) is provided so you can view the different screens 
with sample data already filled in. It is recommended that you use the program with the tutorial 
database to get a feel for the program without having to worry about altering live data. When you 
are in the tutorial database, no changes are made to your live database. To open the tutorial 
database, select Start, Programs, Gradience, Data. 

The Help Menu 

From the Help menu, select Contents. A listing of help topics is displayed. Select the Book that 
interests you (using a double-click), and then double-click the topic you wish to display.  
   



The F1 Key 

Pressing the F1 key is another way to obtain help within the program. From most areas of the 
program, pressing  F1 will display the topic associated for that screen.  
   



Searching for Help 

You can search for Help two ways using the Help File.  
Method 1 – From the  Help menu, select  Search for Help on. The Help Topics Index will 
appear. Select the Topic that interests you.  
   
Method 2 – From the Help menu, select  Contents. Click the  Find Tab. If you have not used this 
feature before, the Find Setup Wizard will walk you through setting up the search index. Once the 
search index has been created, type in the Keywords you would like to search for, and the 
results will be displayed.  
   

A list of typical errors or messages that were known at the time of publication is in Appendix B – 
Troubleshooting.  
   

For more complete information, please refer to one of the following: 

• Read me. txt file in the C:\Program Files\ Gradience\Common program directory.  
• Help File in C:\Program Files\Gradience\Common or accessible from the Start Menu.  
• Internet Site www.gradiencesupport.com 

   
   



Importing       

You may import only the fields on the Field Layout There are two different file formats that you 
may import from:  

• Tab Delimited (recommended)  
• Fixed Length 

  
For a Tab Delimited format, you may use any program that allows you to save as Tab Delimited. 
Excel and Access are two that will allow this. Tab Delimited is the recommended format.  
  
Note: You cannot import directly from an Excel file (.xls extension). Once you have finished 
formatting your data in the Excel file, you will need to save as type: Text (Tab Delimited). When 
entering your information into a spreadsheet such as Excel, you will need to follow the order of 
the field names according to the Field Layout page.  
  

For example, the columns should have SSN first, then Last Name, First Name, etc. Also, you will 
need to leave a blank column for any fields that you will leave blank. For example, following the 
format on the Field Layout page, we create a Tab Delimited file with the fields: SSN, Last Name, 
First Name, [blank column for Middle Initial field], Location, Department, Date of Hire, Full/Part 
Time, [blank column for Title field], [blank column for Employee Code field] and Active Status. 
All of the fields in bold are required, which means that these columns may not be blank. We 
would still need to have a blank column for MI, Title and Employee Code in the order of the fields.  
  
For a Fixed Length format, you may use the DOS Editor or any other editor that shows you the 
field length. The lengths of each field must correspond to the Length column under the Field 
Layout page. We recommend using the Tab Delimited format.  
  

Preparing the software for Import 
You must create/setup your Locations and Departments in the gradience program before 
importing. In other words, you must go to Settings > Locations/Departments from within the 
gradience program and enter your locations and department names before importing your data. 
Please refer to the manual for instructions on creating your Locations and Departments. 
  

Import Field Layout 
  

The following is the field layout for importing text files into gradience. Fields shown in bold type 
are required and all import text files must include them. The alphabetical arrangement as 
indicated by the letters on the left indicates the columns under which the information would fall 
within an Excel spreadsheet.  
  

You MUST have a column for each type of information (both “required” & “Not-required” data) 
shown below. Only the items in BOLD below are required. The items not in BOLD below are not 
required fields but the columns which would contain the non-required information MUST exist 
even if they are blank. The data may not be required but the column that would contain such data 
is.  
  

For example:  
If no Social Security Number is available, column A is still required but may remain blank. The 
Last Name is required and MUST appear in column B.  
  

Field Layout Requirements: 
Social Security Number 11 123-45-6789 
Last Name 20 up to 20 characters 



First Name 
20 up to 20 characters 

Middle Name 20 up to 20 characters 
Location 50 up to 50 characters 
Department 50 up to 50 characters 
Date of Hire 10 MM/DD/YYYY (slashes required) 
Full/Part Time 9 Full-Time or Part-Time (only) 
Title 30 up to 30 characters or numbers 
Employee Code 14 up to 14 characters or numbers 
Active Status 10 Active, Inactive, Terminated 

If you have Confidential Employee Record installed, your text file can also include the 
following fields:  

  

Date of Birth 10 MM/DD/YYYY (slashes required) 
Address 1 30 up to 30 characters or numbers 

Address 2 
30 up to 30 characters or numbers 

Home Phone 30 800-123-4657 (dashes required) 
City 30 up to 30 characters or numbers 
State (2 character) 2 2 characters, i.e., FL 
ZIP Code 15 33325-1234 (-1234 can be omitted) 
Salutation 5 Mr., Mrs., Ms. or Dr. (only) 
Employee Security Level 16 up to 16 characters or numbers 
Security Clearance Date 10 MM/DD/YYYY (slashes required) 
Race 25 Must match a valid race on detail tab. 

EEO Category 25 Must match a valid category on the detail tab. 

Sex M/F 1 M or F only 

Driver's License Number 15 up to 15 characters or numbers 

I-9 Renewal Date 10 MM/DD/YYYY (slashes required) 

Veteran Status 25 Disabled, Vietnam Era, Other Veteran 

Office Phone & Ext. 30 800-123-4567 Ext. 123 

Fax 30 800-123-4567 

Email Address 30 up to 30 characters or numbers 

Address Effective Date 10 MM/DD/YYYY (slashes required) 

  



Exporting       

The export feature is used to transfer basic employee information into a text file that you can 
open in any word processor or spreadsheet application. Only the basic information (see Field 
Layout) will be exported.  
To export your information, follow these steps: 

1. Click File > Export. 
2. Select Tab Limited or Fixed Length for the Export File Type. 
3. Enter a path and file name or keep the default name. 
4. Click Export.  

Your export file will be created as the file designated in the file block. You may rename the file, 
but we recommend keeping the file extension of .txt. After exporting, you may open the file from 
within any other spreadsheet or word processor program.  
   
NOTE: Only the information in the Field Layout will be available for export.  
   

   



Importing and Exporting Data 

The import function allows you to add new data from a text file into the Gradience program. 
Conversely, the export function allows you to export data from the Gradience program. 
   

The software you export your data from must be able to export the required information to a Tab 
delimited or fixed-length text file. See the required import fields. Please note that we cannot 
provide support for other software program(s). Please contact the software vendor or 
manufacturer for more information on how to export data from your other software. 
   

   



Import Features       

Feature Description 
Load 
File 

Loads the selected file into the data window. 

Test  This tab will not highlight until a file is loaded. This checks for blank records and ensures that the 
department and location names that are being imported are already in the database.  

Import This tab imports the file into the database.  
Help This brings up the Help file pertaining to Importing. 
Close This closes the Import screen and takes you back to the main screen. 

 
Feature Description 
Import File  This allows you to enter the path or navigate to the file you will be importing.  
File Type  This allows you to select the file type.  

a.   Tab Delimited – We recommend exporting or importing as this type of file.  

b.   Fixed Length – Gradience may export or import fields with a fixed length.  
Skip First 
Line  

This will take out the first row, in case you have headers. 

Check 
Duplicates  

This allows you to check for duplicates against the import file and the files already in the database. 

   



Backing Up  

How often should you back up? 
Every company is different regarding its backup needs. One thing to remember is, “It’s not if your 
computer is going to crash, but when.” They have made great strides in making computers more 
reliable, but that just makes the time longer before something can happen to your computer.  
   

The following pertains to any data on your computer and not just your Gradience program. Ask 
yourself this question, “If my computer were to crash right now, how long would it take to re-
create (reenter) all of my data without a backup?” Then ask yourself, “If I had to restore from a 
backup, would I be OK with last week’s backup, when I have to re-enter a week’s worth of data? 
Would I be OK with restoring a backup from three days ago? 
   

When restoring your data, the information will be only as current as your last backup. So, if you 
did a backup two weeks ago and had to restore this backup, you would need to reenter the data 
that didn’t get backed up.  
   

Back up after you make changes to your employee records.  
It is recommended that you back up your database after making any significant changes to 
records. For example, any time you enter several employees or input many changes to absence 
information would be a good time to back up. You also may set up the DB Monitor to 
automatically back up at assigned times.  
   

Rotate backups and store backup copies offsite.  
A good backup routine is to have at least three sets of backups covering different days of the 
week. This practice is called rotation and reduces your risk of data loss. It is also a good practice 
to always keep one copy offsite in case of a fire or flood. Consult your system administrator for 
your company policy regarding data storage.  
   
A Restore is when you recover from a backup. There are three different uses for the restore 
feature.  A Restore may be done only through the DB Monitor.  

1. To overwrite the current data with archived data. 
2. To recover from a hardware crash. 
3. To move information onto a new computer. 

   

Please keep in mind, when you restore data, your information will be only as current as the 
backup you are restoring from.  
   

IMPORTANT NOTE 
The backup file may be saved only to the Server or Standalone Computer where the database 
resides. The backup creates a zipped file with an extension of .gbk.  
   



Creating a Manual Backup from Within Gradience 

To perform a manual backup from within the Gradience program, follow these steps: 
1. From within Gradience, go to File > Maintenance > Backup > Backup Database. 
2. If you are running the backup utility from the Server or at a local PC in which the database 

resides (Standalone), you will have the option to select where you want to back up to. If 
you are running the back up utility from a Client (Gradience client install), it will 
automatically run the backup, saving the data where the database resides.  



Creating a Manual Backup from Within DB Monitor 

To perform a manual backup from within DB Monitor, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, Gradience Maintenanceand 

clicking on DB Monitor.  
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your administrator.  
3. Click the Backup Tab.  
4. Click Yes to the message,  “Do you want to perform a sweep after the backup 

completes?”  Note: A Sweep is a maintenance feature that keeps the database working 
at peak performance.  

5. Click OK at the Select Directory screen. It is highly recommended that you keep the 
default location.  Note: You may back up only to the Server or standalone computer where 
the database resides.  

6. Click Close when the backup is complete.  
   



Scheduling Automatic Backups 

To create a scheduled backup, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, Gradience Maintenance, 

and clicking on DB Monitor.  
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your administrator.  
3. Click the Backup Tab.  
4. Click New Backup.  
5. Enter the Backup Type by selecting Daily, Weekly or Monthly.  
6. Enter the military time when you would like the backup to take place.  
7. It is recommended to keep the other default settings of Performing Sweep and the path of 

the backup. A different backup will be created for each scheduled backup. Note: The 
name of the backup will be: [Type]_Backup_[mm-dd-yyyy]_[time] to distinguish it from 
other backups. For example, Weekly_Backup_08-02-2008_2300, or 
Monthly_Backup_09_01_2008_1700.  

8. Click Save. The backup will be performed within a minute of the scheduled time.  Note: 
The Server or standalone computer containing the database must be turned on for the 
backup to complete. If the computer is not on at the scheduled time, the DB monitor will try 
to create the backup the next time it is opened.  



Restoring from a Backup 

Remember, restoring a backup will overwrite all data in the current database. Restore may be 
run only from the DB Monitor on the Server or standalone computer. To restore, follow these 
steps: 

1. Go to the Server where the database files are stored. (Restore cannot be done from a 
Workstation.) 

2. Open the DB Monitor program by going to Start, Programs, Gradience Maintenance, 
and clicking on DB Monitor.  

3. Enter your login and password. If you do not have access to the DB Monitor Restore 
feature, you will need to see your administrator.  

4. Click the Restore Tab.  
5. Click the database to restore.  
6. Click Browse and double-click the backup you wish to restore.  
7. Click Start Restore.  
8. After Restore is complete, click Hide to minimize the DB Monitor.  

You may open the program to see your restored data.       
   



DB Monitor  

Go to Start > Programs > Gradience > DB Monitor. 
   

The DB Monitor allows you to change the Server Name and Database Path, Backup and Restore 
your database, view database information and clear inactive connections. It also will show you 
what Gradience version each client computer is running. This is good to make sure everyone is 
on the same program versions.  
Feature Description 

Settings This allows you to change the Server Name and Database Path.  
Backup This allows you to set up a backup schedule or back up now. See above for creating a backup. 
Backup History This shows all backups completed. You will need to manually delete old backups from within 

Windows Explorer. 
Restore This can be done only from the same drive in which the database resides. For example, if the 

database was on a Server, the restore could be done only FROM the Server, not from the Client 
Workstation. See above for steps on restoring. 

Information This allows you to view how many users are connected to the database and where the current 
database. The Server Version information is the version of Interbase (database).  

Statistics This gives information on the database. Normally you will not need this information.  

 
Connections This allows you to view who is connected and any inactive connections that need to be cleared.  

   

Clearing Connections 
Go to Start > Program Files > Gradience and select DB Monitor.  
   

To clear a connection, follow these steps: 
1. Make sure all users are out of all Gradience programs. 
2. From the Connections Tab of the  DB Monitor, click on the  Refresh button and make 

sure all Computer Names have an “N” under Active Connections. 
3. Click Clear Inactive Connections. This will clear all connections listed with an “N” under 

Active Connections. 



Performing Maintenance and Repairing the Database       

The DB Maint is different from the DB Monitor. The DB Monitor utility allows you to view current 
connections, back up and restore, and view backup history. The DB Maint utility allows you to 
perform maintenance and attempt to repair a corrupted database.   



DB Maintenance Utility        

Details:  
  

Note: This can only be run at the computer where the database is located.  
  

When should it be run?  

• Run it any time that the program performs oddly. If you perform a routine task but get 
unusual results you may have database corruption.  

• We recommend that you also run the database maintenance once per month regardless of 
program performance.  

  

Why should it be run? 
Run this utility to remove database corruption. A database can become corrupt a number of 
ways.  
  

One way the database can become corrupt is through an electrical interruption. We recommend 
that any workstation running the software be connected to a UPS (Uninterrupted Power Supply) 
An inexpensive UPS will give you enough time to close programs and shut down the computer 
properly after a power failure.  
  

Another cause of database corruption is when someone who is running a Gradience program or 
Gradience TimeStation that has been minimized, turns off the computer without first closing the 
program or the TimeStation.  
  

How is it run? 
1. Click on their Windows Start button.  
2. Click Programs.  
3. Click gradience. 
4. Click Maintenance and select DB Maintenance.  
5. Click the Start button that appears on the DB maintenance screen. This should remove 

the corruption from the database.  
6. Close the DB maintenance utility when it is finished and try to open gradience again.  

  
If you have run this utility to resolve a performance issue but the issue persists you have 
two options: 
  

Option One:  
Restore from a recent backup that was made prior to the issue that is now occurring. You will lose 
any data that had been entered since the time that the backup was made.  
Option Two:  
Do a backup and attach the backup to an e-mail and send it to Technical Support. Technical 
Support will “attempt” to remove the suspected database corruption that may be the cause of 
your underlying issue. Technical Support will return a clean backup to you that you can then 
restore into your database.  
  
Note: Although Tech Support clears out corruption in nearly every case, there is no guarantee 
that they will be successful. Be sure to let Tech Support know what the name and the “full” multi-
digit version number of your program.  

  
To find the “full” version number from within he program click on Help (next to Reports) and 
then, click on About 



Database Repair 

If you can’t open the Gradience program, we recommend running the DB Maint utility. It will 
attempt to repair a corrupted database. If the utility does not repair the database, please save 
screen shots of the error messages and contact Tech Support.  
  

We recommend that you make a backup of your database and send a copy of the backup to Tech 
Support via e-mail. Tech Support may be able to repair it. 
If tech Support is able to repair it, they will e-mail it back to you. You can then, restore it into your 
database. 
If Tech Support is NOT able to repair it, you will be advised to restore the most recent backup that 
was made before the problem occurred.  
  
   



DB Maint Features 

The DB Maint utility has the following features: 
Features Description 
Start Begins the maintenance or repair. 
Cancel Stops the maintenance or repair process.  
Print Prints the error message(s). The Print button will not appear unless there are errors. 
Copy Copies the error message(s) to the clipboard. This will allow you to paste it into an e-mail. The Copy 

button will not appear unless there are errors.  
Close Exits the DB Maint utility. 
   
Note: The DB Maint utility will attempt to repair the database that the hrware.ini file points to. (Go 
to Start > Run, and enter: hrware.ini. Locate [HRWARE] in brackets and see the Server name 
and Path for the directory of the Gradience database.) 



Troubleshooting 

Here are the most common problems you may experience when using Gradience.   

• Unable to connect to Interbase Server 
• Getting SQL Parse Error: EOF in String Detected message when logging in 
• Unable to install on a Win NT or 2000 system 
• Exceeded the authorized user count 
• Moving database from one location to another 
• Installing Gradience files to another drive other than c:\ 
• Installing Update from one location 



Frequently Asked Questions 

  

What is a user? 
Simply put, this is the person using the program. They may be entering or viewing data. The 
Administrator may set specific access to only those features a user will need access to. 
  

How many different users can be set up? 
The security file can contain a list of as many users as you desire. For example, each user would 
have their own login name and password with access rights to specific features. 
  

Can I set up each user to view only his or her own employee information? 
Yes. (See Setting Up Access To Locations, Departments and Individual Employees.) 
  

Can Managers view ALL departments or just their own? 
You may set up access for managers to view only their departments and/or view specific 
employees from other departments. You may also set up each employee to have read-only 
access to his or her records. 
  

Why should I change the default ADMIN password? 
The program is set up with a default logins full rights (Admin). We highly recommend changing 
the password for the Admin Login and set up other logins as necessary. 
What is Security Access? 
 
Setting up security access is necessary to allow others access to the program. It is recommended 
that you do not give out the Login and Password to the Admin login. The Detail screen is the first 
screen that comes up when going into User Security. You will need to set up access to the 
common features, the locations and departments’ screen, and the specific program features. 



Unable to Connect to Interbase Server             

Users Affected 

Gradience Attendance 

Gradience Records 
Gradience TimeClock 
   

Issue 

When launching one of the programs above, the following message may be encountered: 
   

"This program was unable to connect to your Firebird/Interbase Server. This likely is due to the 
fact that the default Interbase User Account has been changed. Please provide a User Name and 
Password with Administrative Privileges to Interbase." 
   

Description 

Users may encounter this issue for one of the following reasons. 
If running from a Server: 

1. If you're using an NT server and trying to install the database files to a drive other than C:\, 
permissions to the database folder may be incorrect. 

2. If running from a Standalone Computer: 
3. Interbase Guardian may be shut down 
4. If running from a Client Workstation: 
5. Incorrect Server Name and/or Database Path 
6. Client needs to have TCP/IP installed 
7. Server may be down 
8. Attempting to launch remotely. Remoting tool cannot resolve "Localhost" or "Name of 

Server." Change these to the Server's IP address in the hrware.ini file. 
Possible Resolution 

1. If running Gradience from a Server and encountering the above problem, try each of these 
solutions: 

2. Check your permissions for the Database folder. Full Control access must be given to 
System for the database folder. You may add to the Permissions by going through 
Windows NT Explorer and going to Properties by right-clicking the database folder. 

3. Check to make sure Interbase Guardian (or Interbase Manager) is running. 
4. On a Win 95/98 system, there will be an icon in the system tray (next to the clock). The 

icon graphic appears as a gray tower with a green flag. When you put your mouse over the 
icon, it will read, "Interbase Guardian". This icon will not appear on a Win NT/2000 system. 
You may check to see whether it is running on a Win 95/98/NT/2000 system by clicking on 
Start, Settings, Control Panel and clicking on the Interbase Manager. If it is not running, 
click on Start (from within the Interbase Manager), then try to open the Gradience 
application again. 

5. If encountering the message when running from a Client Workstation, try this: 
6. Check the Server Name and Database Path by going to the Server, opening the 

Gradience application and clicking on Help, System Information and printing out this 
information from the TechSupport Tab. (If you don't have the TechSupport Tab, then you 
have an earlier version of Gradience and will need to do a screen shot of the System 
Information screen and Current Users screen and print them out.)  

7. Once you have the Server information, go to the Client Workstation you cannot connect to 
the Server with. From the Workstation, click on Start, Run, and enter: HRWARE.INI. Verify 
that the Server Name and Database path are the same. 
   



NOTE: The printout of the Server Name and Database path you were asked to print or 
write down when installing the Server side must be exactly the same when entering this 
information on the Client Workstation(s)!  
   

8. The Client needs to have TCP/IP installed. 
9. This is done through the Network Neighborhood Properties. Please see your Network 

Administrator if you need more assistance in setting this up. 
   

If everything is the same on the Client as it is on the Server and you're still unable to 
connect, then try this: 
   

If your Server has a static IP Address, try entering this for the Server name when installing 
to the Client Workstation. 
   

10. If running from a Client Workstation and you went through the steps above and it didn't fix 
the problem, check with your MIS or Network Administrator regarding the status of the 
Server. 

   



Getting SQL Parse Error: EOF in String Detected                   

Issue: Getting an error message when logging in. Receive the following error message when 
logging in: SQL Parse Error: EOF in String Detected 
   

Description: This is caused when pressing the comma key ( , ) and Enter key at the same time. 
   

Possible Resolution(s):  

Avoid pressing the comma and Enter key at the same time.  



Installing Gradience Files to Another Drive Other Than C:\ 

Issue: 

Installing Gradience files to another drive other than the C:\ drive. 
   

Description: 
Sometimes installing to the C:\ drive is not feasible. It may not have much space left or it’s not 
meant for database files.  
   

Possible Resolution: 
When installing Gradience, there are three sets of files that get installed: Program Files, 
Database Files and Database Engine Files (Interbase). When choosing Custom Install, you may 
select the location for the Program and Database Files that get installed at the same time. 
Interbase automatically will install to the c:\ drive after you click on the first Finish button. If this is 
OK, then you only need to follow Step 1 below and click on Finish. Otherwise, if you also want to 
install Interbase to another drive, then follow all of the below steps: 

1. Run the installation of the selected Gradience program (such as Gradience Attendance , 
Records or TimeClock. When going through the installation process, choose Custom for 
the Installation Type. For the next two screens (Program Files and Database Files 
Location), click Browse to choose where to install them.  

2. Stop at the point where it says FINISH. Do not click on it. Leave the install window open at 
this screen. Open Windows Explorer and go to the Windows Temp directory. 

3. From the Windows Temp directory, find (or do a search for) IBWin32setup.exe. 
4. Double-click on this file to start the installation process. This will install the database 

engine files (Interbase) and give you the ability to install these files to a drive other than 
C:\.  



Moving Database from One Location to Another 

Steps to follow:  
1. Install the software on the new server. (See Installing Gradience).  

 
Note: In the event that you have had your CD for a number of months you may not be 
running the latest “edition” of the version you own. We recommend that you download the 
latest ‘edition” of your version from our Tech Support web site. 
 
Go to www.gradiencesupport.com and click on Download latest versions.  
 

2. Download the appropriate program, saving it to the desktop of the server.  
3. Install it on the server doing a Server installation and then pick Custom or Express. This 

will create a new “blank” database on the new server. Take note of the location of the 
database, return to your client workstation(s)  

4. From the desktop of each client workstation click Start > Run. Enter hrware.ini into the 
field and click OK. A NotePad window will open.  

5. At the top you will see the following …  
[HRWARE]  
SERVER= (the name of the computer where the database had been)  
PATH= the path to the database)  
The second and third lines may be reversed on your ini file.  

6. Edit the SERVER name and if necessary, edit the PATH line, Save and close. This will 
“point the program on this computer to the new database location. There is no data there 
yet so the program will not open yet.  

7. Go to the computer where the database had been. Open Windows Explorer (not internet 
Explorer).  

8. Navigate to the database (Hrware.gdb), “Copy” it, Paste it into a shared folder on the 
network and close Windows Explorer.  

9. Go to the new server and navigate to the shared folder and “Copy” the database 
(hrware.gdb).  

10. Navigate to the new, “blank” database (hrware.gdb). Paste the copy of the original 
database into the same folder. This will overwrite the new, “blank” database with a copy of 
your production database.  

   



Installing Gradience 

1. You may install from a CD or from a download.  

• From a CD:  
Insert the gradience CD, select Install gradience software and double-click on the program 
to be installed.  

• From a Download: 
After following the instructions on downloading Gradience to your desktop, double-click on 
the file to install.  
 
Note: To download, go to www.gradiencesupport.com, click on Download latest 
versions. Select the program that you need, click Download and then click Save. When 
the Save as window opens, put Desktop in the Save in field and then, click Save. 

2. You may install as a Server, a Client or a Stand Alone. 

• Server Installation: 
If installing several gradience programs on your network, only one program needs to be 
installed at the server.  
 
When prompted for the type of installation select Sever. When prompted for Custom or 
Express we recommend Express. If you select Custom you will be given the chance to 
“deselect” certain components. We recommend that you leave all components checked. 
The next prompt will allow you indicate where you want the database to reside. Please 
indicate a folder on physical drive rather than on the drive directly. An example of a custom 
path would be… 
 
j:\gradience\hrware.gdb  
 
Continue to follow the prompts. You will see a screen that shows where the database is 
located. Jot this location down or print this screen as prompted. You will use it at the client 
to verify that it is “pointed” properly to the database.  

• Client Installation: 
DO NOT map a drive from the client to the server. Our software uses TCP/IP to connect to 
the database via port 3050. Also DO NOT use UNC (\\) in either the name of the server or 
the path to the database.  
 
When prompted for the type of installation select Client. When prompted for Custom or 
Express we recommend Express. This workstation will look across the network and “self-
point” to the data up on the server. A prompt will indicate where this client is “pointed”. 
The client MUST be pointed to the exact drive letter on the server where the database is 
located, not a mapped drive. Be sure that the path to the database does NOT have double 
back-slashes (UNC) in the path.  

• Stand Alone Installation: 
When prompted for the type of installation select Stand Alone. When prompted for 
Custom or Express we recommend Express. If you select Custom you will be given the 
chance to “deselect” certain components. We recommend that you leave all components 
checked. The next prompt will allow you indicate where you want the database to reside. 
The database must reside on a physical drive and in a folder on that drive rather than on 
the drive directly. An example of a custom path would be…  
 
j:\gradience\hrware.gdb  



Possible Launch Error:  
 If after installation, you attempt to open gradience software from a remote location you may 
encounter an error message. Some remote-access software cannot resolve Localhost or the 
“name” of the server that can be found in the hrware.ini file of the server, client or stand alone 
workstation respectively. 

Resolution: 

1. 1. Remote to the desktop of the PC where you are attempting to open the program. 
(Server, Client or Stand Alone PC)  

2. 2. Click on Start > Run and enter hrware.ini into the field and click OK.  
3. 3. Second line from the top, change the “Server Name” or “Localhost” to the IP Address of 

the computer where the database is located.  
4. 4. Save and close the NotePad. Re-launch the program. If this fails, “physically” go to that 

computer to launch it.  



Install Update from One Location  

Issue: 
When a new update is released, you must install at each client workstation(s) and at the 
database server. These instructions will show you how to set up the Gradience folders to install 
only the new update once from one central location.  
   

Description: 

Setting up one shared directory for the program files will make updates quicker and easier.  
   

Possible Resolution: 
These instructions will explain how to set up the Gradience program files in one shared location 
to make updating easier: 
   

1. Copy the Gradience installation file(s) to a shared directory. The Server and all 
workstations that will have (or already have) Gradience installed should have access to 
this shared directory on the network. If you downloaded the Gradience update from our 
Web site (www.gradiencesupport.com), then you will have only one file. If you have a 
Gradience CD, then you will need to copy the appropriate Gradience program keeping all 
of its folders intact. For example, while navigating the Gradience CD through Windows 
Explorer, under the BIN folder, you would copy the Atcon70 folder to the shared directory.  

2. From the Server (or computer where the database resides), navigate to the shared 
directory, and run the Server installation (even if the Gradience program already is 
installed on the Server) by following these steps: 

1. At the Setup Type, select  Server. Click  Next. 
2. At the Installation Type, select  Custom. Click Next. 
3. At Select Components, leave the defaults. Click Next. 
4. At the Program Files Location, click Browse and navigate to the Shared directory. 

Add \Gradience to the end of the Path. 
5. At the HRWare Database Files  Location, click Next. 
6. Write down or print the Server Name and path. These will be needed for the Client 

installs. Click Close, then Next. This will install the Server files. 
7. If the Interbase install starts, click Next to install it; otherwise, go to Step  H. 
8. Go to Client Workstation. 

3. From the Client Workstation, navigate to the shared directory, and run the Gradience 
installation (even if the Gradience program already is installed on the Workstation) by 
following these steps:  

1. At the Setup  Type, select  Client. Click  Next. 
2. At the Installation  Type, select  Custom. Click  Next.  
3. At Select  Components, leave the defaults. Click  Next. 
4. At the ProgramFiles Location, click Browse, and navigate to the \Gradience 

shared directory created during the Server install. Click Next. 
5. At the Database Server Information screen, enter the Server name and database 

path exactly as shown from the Server install.  
6. Click Next. This will install the program files. 
7. Follow the above steps for any other Client Workstations that will have Gradience 

installed. 
   
When the above steps are completed once, then when you need to install an update, only 
steps 1 and 2 (a-g) need to be completed. All users must exit the Gradience program(s) before 
updating. All of the shortcuts on the Client Workstations will be pointed to the shared directory 
that will be updated when the Server install is completed. 
   



Unable to install on a Windows 2000 system             

Issue: Doesn’t finish installation. 
   

Description: This usually happens if you do not have full administrator rights on the Windows 
2000 computer. 
   

Possible Resolution(s): 

Make sure you have full administrator rights before installing.  



Exceeded the Authorized User Count             

Issue: 
You have exceeded the authorized user count. Your product license allows up to [number of 
licensed users] simultaneous users. There are # connections at this time. 
   

The # connections is a number greater than one that changes each time you close and reenter 
the program. 
   

Description: 

Users may experience this problem when closing the program by clicking Exit under the File 
menu. Users who exit the program by clicking the close window icon in the top right corner will 
not experience the problem, but we still recommend downloading and installing the latest update.  
   

Possible Resolution: 
Download and install the latest Gradience program from our Updates area on our Web site at: 
www.gradiencesupport.com. 
   

Please follow the installation instructions. After downloading and installing the update, follow the 
steps below to clear the connections. 

1. Close Gradience and any other Gradience Programs that are open. 
2. Open DB Monitor and log in, if it is not already running. The DB Monitor resides on the 

computer where the Gradience database is installed. 
3. Click the Connections button. 
4. Click the Refresh button to verify all connections are "N" (not active).  
5. If all connections are "N", then Click the Clear Inactive Connectionsbutton. This will reset 

the connections.  
6. If you wish to close the DB Monitor (not recommended if you have automatic database 

backups scheduled), right-click on the icon Gradience Database Monitor in the system 
tray area; select Shutdown Database Monitor, and click OK to close DB Monitor. 

7. Otherwise, click the Hide button. 



Adding Attachments to Comments or Notes 

  
Each Comment or Note field allows you to insert an attachment to that field. Attachments can be 
a Microsoft®Word Document, Microsoft® Excel spreadsheet, PDF, Rich Text Format, or even a 
picture file. Attachments may be linked to a file, displayed as an icon or inserted into the field. 



Insert Object Options 

  
Create New 
Selecting Create New allows you to insert a new object that you want to create from scratch. For 
example, selecting Create New and clicking on Microsoft® Word Document for the Object Type 
and then clicking OK will bring up a blank Word Document for you to enter text. When you close 
out of the Word Document it will appear in the Comments field. Double-clicking on the Word 
Document object will bring up Microsoft® Word so that you may again edit the document. 
  

If the Display As Icon option is checked, then the Word Document (or object type) will appear as 
an icon in the Comments field. 
  

Create from File 
Selecting Create from File will allow you to insert an existing object type, such as a 
Microsoft®Word document, PDF file or Excel spreadsheet. Normally, this will be the option you 
will use for every day use. 
  
If you do not select the Link or Display as Icon option, then the object type will be inserted into 
the Comments field. In other words, you will see the text as you would see the text on a Word 
Document within the Comments field. Double-clicking on this text in the Comments block will 
bring up Microsoft®Word so that you may edit the document. 
  

We recommend selecting the Display as Icon option when inserting an object. This inserts the 
object type within the Comments field; however, it shows as an icon. When you double-click on 
the icon, it brings up the object within the program that created it. 
  

The Link and Display as Icon options will perform the following, depending on your selections: 
Selected  
Link Display 

As Icon 
Results 

  Inserts the contents of the file as an object into your document so that you may activate it using the 
program which created it. 
 

X  Inserts a picture of the file contents into your document. The picture will be linked to the file so that 
changes to the file will be reflected in your document. 
 

 X Inserts the contents of the file as an object into your document so that you may activate it using the 
program that created it. It will be displayed as an icon. 
 

X X Inserts a shortcut that represents the file. The shortcut will be linked to the file so that changes to the 
file will be reflected in your document. 



Inserting an Attachment 

  
To insert an attachment, follow these steps: 

1. Locate the Comment or Note field you want to insert an attachment into. 
2. Right click on this field and select Insert Object. 
3. Select Create from File. 
4. Click Browse to navigate to the file you want to attach and click Open. 
5. Select Display as Icon. 
6. Click Change Icon and change the Label, if necessary, to make the name more 

descriptive. 
7. Click OK, then OK one more time. 



Using the Notes/Comments Editor and Attachments 

  
Gradience Records 2008 includes new, powerful word processing features for all comments and 
notes fields, as well the ability to attach objects and documents within these fields. When 
documenting employee absences, you may find it useful to attach, copies of e-mails, Word or 
Excel attachments that you’ve used for tardies, warnings and specific sections of reviews 
Gradience Forms personnel forms for vacation requests, FMLA requests and company 
responses, warnings and counseling reports 
  

Right-Click Menu Commands 
Right-click on any notes or comments field – the menu shown at right will pop up with the 
following options: 

• Edit – Opens the full text editor 
• Cut – Copies to the clipboard and deletes the currently selected text 
• Copy – Copies the currently selected text to the clipboard 
• Paste – Pastes the currently selected text into the comments or text field 
• Font – Brings up a standard font edit window, with settings for font, style, size, effects and 

color 
• Bullet Style – Toggles bullets for selected paragraphs on and off 
• Paragraph – Brings up a standard paragraph settings window for alignment style, 

indentation, and line spacing 
• Tabs – Lets you set tab stops for selected paragraphs 
• Find – Searches for the text you enter 
• Replace – Searches and replaces text according to your settings 
• Insert Object … – Opens the Insert Object window and lets you select either a type of new 

object to insert into the notes / comments field or attach an existing file 
• Check Spelling – Launches the Microsoft®Word spell checker 

  

Using the Rich Text Editor 
  

When you right-click and select Edit, the text editor opens in a separate window, giving you 
access to all Right-Click Menu commands in a word-processor-like environment. Here’s a brief 
overview: 
  

Toolbar 

 New Creates a new document. 

 Print Prints document. 

 Find Finds specified text. 

 Spell 
Check 

Checks spelling. Requires MS Word installed. 

 Cut Cuts selection and puts it on the clipboard. 

 Copy Copies selection to clipboard. 

 Paste Pastes selection from clipboard. 

 Undo Reverses the last action. 

 Redo Reverses the last Undo action. 
Format Bar 

 Font Type Changes the font selection. 

 Font Size Changes the font size. 

 Bold, 
Italic, 
Underline 

Changes the font to Bold, Italic or Underline. 

 Font 
Color 

Changes the font color. 



 Left, 
Center, 
Right 
Alignment 

Changes the text to Left, Center, or Right Alignment. 

 Bullet Inserts Bullet. 

 Highlight Highlights selected text. 



USB Fingerprint (BIO) Reader Setup Guide 

1. From within the management portion click on Settings > Global Preferences > 
Fingerprint Reader.  

2. Then click on Edit and check Enable Fingerprint Reader and then click Save. You will 
have to close out of the program and reopen it for that change to take effect.  

3. After opening the program, enter the management portion.  
4. Select the first employee that needs to have their fingerprint registered and then click on 

Time Clock Access.  
5. On the right side of the screen under the title Fingerprint click on Add. A new screen will 

appear giving you the steps to follow for registering fingerprints.  
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